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Welcome to ConceptDraw DIAGRAM 18 for Windows

Computer Systems Odessa Corporation introduces you ConceptDraw DIAGRAM - a world-class
diagramming software that lets you display, communicate, and present dynamically on macOS and
Windows platforms. ConceptDraw DIAGRAM is powerful enough to draw everything from basic flowcharts
to complex engineering schematics.

World-Class Diagramming

Benefits

ConceptDraw Maintenance Assurance

Technical Support

World-Class Diagramming

ConceptDraw DIAGRAM is a diagramming tool that lets you easily create diagrams in minutes to
support any business communication process. You can create simple or complex drawings to
communicate status or condition to your audience.

ConceptDraw DIAGRAM creates drawings, diagrams and charts with great visual appeal. It is simple to
express ideas to share with others that quickly convwey what you are thinking when using ConceptDraw
DIAGRAM. It is a spectacular, easy-to-use tool for preparing presentations and business documentation,
describing structures and processes, making schematic diagrams, and drawing technical sketches.
ConceptDraw DIAGRAM is powerful enough to be the standard-bearer business graphic tool for
organizations of any size, producing rich visual documents that convey meaning and support company’s
internal and external communication needs. Graphic company communications include dashboards
displaying key performance indicators and depiction of processes based on company data. From simple
to complex, ConceptDraw DIAGRAM fills every niche.

Your Benefits

Simplifies and enhances presentation generation with flexible slide construction, automated processes,
and Live Object technology for displaying external data. Contains an extensive library of over 20,000
ready-to-use objects, with hundreds of templates and examples to get you started quickly.

ConceptDraw DIAGRAM also supports dynamic presentations that contain live content and can be
edited on the fly to reflect input from collaboration or feedback. Presentations can be exported to
numerous graphical formats or emailed as a slide show. ConceptDraw DIAGRAM presentations can be
displayed in full-screen, automated playback mode, or using dual monitors — display on one, edit on the
other — for team collaboration.

ConceptDraw Maintenance Assurance
We have developed an innovative maintenance program that makes sure you stay up to date. At the time
of your buy a ConceptDraw product, you are able to purchase ConceptDraw Maintenance Assurance

Technical Support

We offer unlimited free technical support to our users.

To send us a problem report or feature request, submit the ticket form in the Help Desk section on our
Web site.

Replies are normally sent within one business day. We are always happy to answer your questions and
hear your feedback.



https://www.conceptdraw.com/helpdesk/how-to-upgrade-from-previous-versions
https://helpdesk.conceptdraw.com/ticket.php

Toolbar Tour
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The ConceptDraw DIAGRAM toolbar provides quick access to functions that are commonly performed
within the program.

Quick Access
File

Home

Shape
Document
View

Share

Developer
Help




Quick Access

Boi»mnHE
Quick Access menu facilitates access to the most frequently used functions. It is located at the top of
Toolbar.

New Document - Create new blank document
[l Open - Open existing document
¥ Undo - Undo the last action
Redo - Redo the last undone action
M save - Saw the current document

2. Print Preview - Preview and make changes to pages before printing




Help Menu

© ConceptDraw DIAGRAM Help  F1
At Keyboard Shortcuts

o= Getting Started

@ Online HelpDesk

3 Check for Updates
i ]

About ConceptDraw Ctrl+F1

ConceptDraw DIAGRAM Help: Calls the ConceptDraw DIAGRAM Help System. It opens in a separate
window where you can see a number of articles containing information on how to use the product. You
can read or print the articles, search them for the needed information.

Keyboard Shortcuts: Calls the ConceptDraw DIAGRAM ready-to-print list of the keyboard shortcuts in
pdf format

Getting Started: Opens the Getting Started guide in the PDF format
Online Help Desk: Allows you to ask a question to ConceptDraw DIAGRAM Support Team

Check for Update: Runs ConceptDraw STORE and opens the Available Updates tab

About ConceptDraw: Opens the About window, where you can see the information about the
application version and dewelopers.




File

File

The File tab provides you with access to operations that apply to an entire ConceptDraw DIAGRAM file.
Such as creating a new file, opening an existing file, printing, saving, changing options, etc.

Mew

Shape Document Wiew Share Developer

Recent Documents
Ternplate Setup

= Payment flowchart (for treasurer).cdd
=m C ProgramDatat ConceptDraw Solution Parkd\AREA_FINAMNCE_ACCOUMNTIMGYFA_
i Flowchart-multipage.cdd
=@ P:\Personal\Korlyakova\Sample Diagrams
. Conceptl.cddz
=@ C\Users\anna'Downloads
= . Hosting on AWS_multiage.cdd
=i P:\Personal\Korlyakova'Sample Diagrams
7. Design elements - Organizational chart (people]).cdd
Import =m ProgramData' ConceptDraw Solution Park\AREA_MAMNAGEMENTWING_TOOL_
=  COrgCharts.cddz
Export =@ C\Users\anna\Docurments\My ConceptDraw
F L Procurement process mapping.cdd
Library =i C\Users\anna\Documents\My ConceptDraw
F L Procurement process mapping.cdd
=@ P:\Personal\Korlyakova
: _ 3= Rapid_Draw.cdd
end via Email =@ C\Users\anna\Downloads
Close 7. Hiring process.cdd
- =M C’\ProgramData\ConceptDraw Solution Park\AREA_MAMNAGEMENTMNG_TOOL_
Properties 3= Investment and construction application procedures.cdd
=i C\ProgramData\ConceptDraw Sclution Park\AREA_MAMNAGEMENTMMNG_TOOL_
Options =.  Post Employment Committee recruitment flowchart.cdd
i =m C ProgramDatat ConceptDraw Solution Parkd\AREA_MAMNAGEMENTWMNG_TOOL_

New

Default Blank Drawing: When you create a new blank document, DIAGRAM applies the default
page dimensions, orientation and other settings that are stored in a default template. If you
frequently use settings that differs from the default template, you can set new defaults that
DIAGRAM uses when you create a new document;
US Letter Drawing (Portrait): Create a new US Letter size document with a portrait page
orientation;
US Letter Drawing (Landscape): Create a new US Letter size document with a landscape page
orientation;
A4 Drawing (Portrait): Create a new A4 size document with a portrait page orientation;
A4 Drawing (Landscape): Create a new A4 size document with a landscape page orientation.
Template Setup: Call the Template Setup dialog.
Open: Call the Open dialog.
Recent: See the list of the recently opened files.
Save: Call the Save dialog.
Save as: Call the Save as dialog.

ConceptDraw DIAGRAM User Interface Reference © 2024 CS Odessa corp.



Import
Graphic File: Import data from graphic formats (emf, wmf, pct, pict, bmp, dib, gif, jpeg, jpg, png,
tif, tiff);
Microsoft PowerPoint: Import data from Microsoft Office PowerPoint Document (.pptx, ppt);
Microsoft Visio Drawings: Import data from Microsoft Visio Drawing (vsd, .vsdx, vdx);
Microsoft Visio Stencils: Import data from Microsoft Visio Stencil (.vssx, vss);
PDF as Image: Import Adobe Acrobat document as image;
SVG: Import Scalable Vector Graphics format.

Export
Adobe Flash (SWF): Save document as Adobe Flash (SWF) file, using Elash Export Settings
dialog;

PDF: Sawve document as Adobe Acrobat (PDF) file;

EPS: Sawe document as Encapsulated PostScript (EPS) vector file;

Graphic File: Save document as graphic file (emf, bmp, dib, gif, jpeg, jpg, png, svg, tif, tiff);
HTML: Save document as HTML file;

Microsoft PowerPoint : Save document as Microsoft Office PowerPoint Document (.pptx, .ppt);
Microsoft Visio 2010 (VDX): Save document as Microsoft Visio 2003-2010 Drawing (.vdx) file;
Microsoft Visio 2013 (VSDX): Save document as Microsoft Visio Drawing (.vsdx) file;

SVG: Sawe document as SVG file.

Library
New: Create new library;
Open: Open an existing library;
Save: Sawe the actiwe library;
Save as: Sawe a copy of active library;
Send via email: Send an actiwe library via e-mail;
Close: Close the active library of the current document;
Close all: Close all libraries used in the current document;
Properties: Show Library Properties dialog box.

Print: Print the current document.

Send via Email: Save the currently opened document and attach it to email message using the default
email client.

Close: Close the currently opened document.

Properties: Allows to configure the settings of the current document in the Properties dialog.

Options: Allows to configure the application settings in the Options dialog.




Properties

The Properties dialog contains options allowing you to configure the parameters of the particular
document.

To invoke it choose Properties... from the Eile menu.

The dialog contains several tabs, which control various groups of settings:

Print Setup - contains information that describes the document

Page Size - sets the size and orientation of the document pages

Info - contains information that describes the document

Units. Scale, Options - sets the scale, units of measure, etc.

Advanced - contains settings that control access, export to HTML, the behavior of connectors.

Print Setup tab

Mew Pmp::l‘tiéﬁ
Pririter Paper
Template Sstup

Print Sebup e

Open
Portrait /
Recent #) Londs Sehp... =
Page Sae Londscepe Frivie
Save Paper
Print Zoom
Save As Inta FTe! | Orignal siz = | Dageds)
Import Paper hmtheaton
a3 LT 1
Lirvls, SCale Opoons
Export ﬂ n n o
Library u n n
Aehvarced u u n Print background pages separately
Print
Send via Email
Close
Apply Ok Cancel

Properties

Options

Printer paper - lets you select printer paper size from the list.

Portrait/Landscape - defines the document page orientation.

Setup... - opens the system printer settings dialog.

Print Zoom - lets you adjust the document pages to the printer pages.

Justification - defines the justification of the document page on the printer page.

Print background pages separately - lets you print the background pages of the document as separate
pages.




Page Size tab

MNew

Prapertios
Document Size:
Template Setup Cistomsae.
Print S
Open s Gnentation: Portrait
e 7
Recent
Fage St Wit Frr BT
Save Wictth: %7 mem o
- Hesgnt: 230 men
Save As Infa
Addjst bo drawing contents
Imyport
et it
Linits, Scake Opitions
Expaort e

Library

| Expaned the page in Rapid Draw
Prant

Send wia Email

Close
Agply Ok Cangel
Properties

Options

The left part of the tab contains the settings. The right part has the preview area, where you can see the
results of the changes you apply. The document page is represented by the white rectangle, the printer
page is represented by the shaded rectangle. The size and orientation of the printer page are taken from
the current print settings.
Document Size setting allows to choose the size of the document page. The following options are
available:
Same as printer paper size - the document page has the same size as the printer page.
Pre-defined size - allows to choose one of the pre-defined sizes from the drop-down list.
Custom size - lets you set a custom page size:
Width - specifies the page width
Height - specifies the page height
Orientation - switch between portrait and landscape layouts
Adjust to drawing contents - the page size is set enough to fit all shapes in the drawing. If the document

contains several pages, the biggest value is used.




Toolbar Tour File Properties

Info tab
New .
= Properties
Template Setug Tithe: | Completed transition schematc - IDEF3 diagras
Open Frnt et Keywords: | [DEF 3 disgram, transition schematic, business
Recent Author: | ConceptDraw PR team
Page Size
Cospany: | C5 Odessa
Save As Infa Descripbion: | This 5DEF 3 diagram example was A
redesgred from the Wikmedia Commons
file: 521 Completed Transibion
IPmpeoet Schematic.jpg.
N [eemencns. wikimedia, orpywild Fle: 5
. Units, Scale Opbions 21_Complebed_Transton_Schemabic.jpg]
Export "As with the Process Schematc, the
ceerectness of the Cibject Schematicand
Library !
’ Mdvanced

Prant

Send i Ernail

Apply ok Cancel
Properties

Options

Title - contains the title of the document

Keywords - in this field you can enter the keywords which the search engines will use to include the
given document in their search results.

Author - contains the name of the author

Company - contains the name of the company

Description - a detailed description of the document

ConceptDraw DIAGRAM User Interface Reference © 2024 CS Odessa corp.
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Units, Scale Options tab

Mew

Properties
s

Template Setup

Print Schup Urits of measre: | milmeters -
Open

Désplay angles in: | degrees -

Recent .

Fage Hre Sesls

= Mo scale (1:1)
Sawe fis Inko Pre-defined scals: (Matric
Custom scala: 1 mm - 1

IPrpeart

Linits, Scale Options
Export
Libyeary

_— Advanced
Print
Send vin Ernail
Close
Aoy = Cancel

Properties

Optians

Units of measure - allows to choose the unit of measure from the drop-down list.
Display angles in - sets whether to display the angles in degrees or radians.
The Scale setting determines the scale of the document. The following options are available:
No scale (1:1) - the 1:1 scale.
Pre-defined scale - allows to choose a scale from the list. The scale is set with the help of two drop-
down lists. The first one allows to choose the type of the drawing:

Metric

Civil Engineering

Mechanical Engineering

Architectural
Depending on the chosen option you can choose a pre-defined scale in the second drop-down list. If the
Civil Engineering or Architectural options are chosen, non-metric (imperial) units of measure are set
automatically in the Units of measure field. You can change the units of measure manually if needed.
Custom scale - sets a user-defined scale. You can use different units of measure by specifying the
appropriate suffix after the value (for example, 1 ft = 1 in).
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Advanced tab

New

Properties
Connachors and Routing

Ternplate Setup

Print Setup ma, Fekeer of legs: | Unbmited = When CroRsng roupE:
Open = Pass through

Min, destanoe to shapes: | 3mm [l

Recent *) Flgw argund

Page Sire Line pump size: | 2 mm =

Protect Access to Document
Infa

Lrsts, Scale Options

Expaort

Library

Pring
Send via Email

Cloze

Apply Ok Carenl
Properties

Opticns

The Connectors and Routing section contains settings that describe the behavior of smart connectors.
Max. numbers of legs - sets the maximum number of connector's legs. By default the number of legs is
not limited.

Min. distance to shape - sets the minimum distance the smart connector keeps from the shapes on its
way.

Line jump size - indicates the size of connector crossings.

Note: This setting only determines the size, not the type and style of the crossing (see the Connectors
Routing section ).

When crossing groups - sets how the connector behaves when it crosses a group:
Pass through - passes through the group, flowing around the shapes inside.
Flow around - flows around the entire group as if it were a single shape.
The Protect Access to Document area lets you limit access to the document. The program will ask for a
user name and password on an attempt to open the document. Only authorized users will be able to view
and edit the document.
Add User - adds a new user to the list using the Edit User dialog,
Edit User - allows to change the user name and password,
Remove User - deletes user from the list.
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Options

Allows you to change default application settings that will be applied to all new documents created in
ConceptDraw DIAGRAM.
To invoke the dialog, choose Options from the Eile menu. The dialog contains several tabs, where
various settings are grouped:

General - contains the default settings for new documents,

View - determines the appearance of some components of the application,

Save - contains the saving parameters of the documents,

Advanced - describes scripting and ConceptDraw Basic Editor settings.

Spelling - contains the saving parameters of the documents.

General tab

Mew .
Opticns & Mewr Diocumenit with Default Settings
Template Setup
e Document with Custom Template
= with €L

Uil Badks & Srsp

UndigRleds Depsh: | 30
L €
Save As Save - =
Snap sensinaly! i pwes
Impart Edit Tt Made Diptions
Adhvnied = Olose edit text by CTRL + Enter or Esc keys

Export

Closer edit text by Enter or B3¢ ltys
— Speling Orter Cptions

Print Uge mouse sorol bo change moom

Send via Email Keep onginal format for nserted images

Clese Embed cbjects nto & conneclor path

Properties Apply [= 4 Cancel

Options

This tab describes the parameters of the documents, created with the New command. You can choose
whether to base a new document on the default settings or on a default template file:

New Document with Default Settings - Document is created with the default Template Setup parameters.
New Document with Custom Template - Choose a template file, on which every new document will be
based. Use the Browse button to choose the file, or specify the path in the edit field.

Undo/Redo and Snap - Set the maximum number of Undo/Redo operations and set the maximum
distance between objects to activate the Snap&Glue behavior

Edit Text Mode Options - Choose options most suitable when working with text.

Other Options - Set of additional options:

Use mouse scroll to change zoom - enable using mouse to change zoom.

Keep original format for inserted images - enable to insert images keeping their original format.

Embed objects into a connector path - enable to insert an object directly in the connector path.

Use the Enter and Esc keys for objects navigation - Navigate from object to object using keys in
addition to using the mouse
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View tab

Wielceme

Hew

Template Setup
Open

Recent

Lave

Save Az

Impan

Expart

Likwrary

Print

Send via Ermail

Chote

Properties

Options

Options
Display Opbons

| Eralbile o ol

| Enable floabig windows doding
o | WYSTWTG St e

| Mark hyperiks n bext

v | Smart ool sewiching

Bustoemabcaly pooen under - paniky whin edang

Adcryrent bo Shickness;

W Libwary wandon soresn Bips

¥ | Shiget sr et g

v | Coninol handie soreen Bps
Speding Shorm developer tab

Shayer ribbon on mose hover

Boply O Cancel

Display Options section determines how text and hyperlinks are displayed in the program:

Enable auto-scrolling - if enabled, the document will be scrolled when you position the mouse
pointer over an edge of the window.

Enable floating window docking - Lets you dock floating windows as tabs when dragging one
window to another.

WYSIWYG font list - If enabled, all font names will be live previewed in the font list.

Mark hyperlink s to text - turns on the hyperlink auto parsing mode.

Small tool switching - allows small tool switching.

Automatically zoom under ... points when editing text - lets you adjust the text editing
functionality. You can enable the auto zoom in the document if the text looks too small, and
set the minimum font size acceptable for text editing mode (setting the font size best
viewed).

Alignment box thickness - lets you adjust the thickness of the selection box. It may be
important for object alignment.

Show section contains settings for screen tips:

Library window screen tips - specifies whether to display screen tips when the mouse pointer
is paused over a library shape.

Shape screen tips - specifies whether to display screen tip for shapes in a document (see the
description of the Info floating dialog and the Information tab of the Shape Properties dialog).
Control handle screen tips - specifies whether to display screen tip for control handles.

Show developer tab - show/hide the Developer tab enabling ConceptDraw Basic Script
editing.

Show ribbon on mouse hover - Allows you to configure whether the Ribbon will appear when
you click on it or when you hover owver it in hidden Ribbon mode
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Save tab

MNews

Options
Fane Dptions

Template Setup

General | Save Autsbacap every | 2 = miraites
Open
Recent Backug foider €:Wsers fanna \AppDatai ccali®S OdessaiConceptiras

View
Save Erowse...
Save Ag S Format Oplons
Import By dafault axve Be | CConoeptOraw DIAGRAM Document, cddr
Export Advenced + | Save warkspace with dotument
Liksrany
Pint
Cend via Ernail
Clase

Apply [a 4 Cangel

Properises

Optians

Save Options section describes the auto-save parameters of the application.

Save AutoBackup every ... minutes - saves a backup copy of the document automatically after the
specified time interval.

Note: if you're working with large multi-page documents, don't specify a very small interval as it may slow
down working.

The Format Options section contains the parameters that set the default format of the document.

By default save file as - sets the format in which new documents will be saved.

Save work space with document - if this parameter is enabled, the document stores the arrangement of
open windows, libraries, etc. This arrangement is restored when you open the document.
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Advanced tab

PMlew

Options

Template Setup gt Seltng
- | Alow o run ConceptDraw Basc sripts sutomaboally
Open General
o) Alleey ggiong Congepiiniey B Srpss
pecet Vi COBas Editor Windw
e Font: | B Calibri
- Sanve
Save As . N
Impart Adhvanced : -
“For every problem, there exists 8 simgle and elegant salution which is
absolutely wrong.” - | Wagoner, U.C S, Mathematics
Export Speling

Libsary

Print
Send via Email

Clerse
Properies

Options

apply o Cancel

The Scripting Settings section sets how ConceptDraw Basic scripts will be treated by ConceptDraw:
Allow to run ConceptDraw Basic automatically - allows the program to run scripts
automatically,

Allow editing ConceptDraw Basic scripts - allows to edit scripts.

The CD Basic Editor Window specifies how the CD Basic Editor window looks. You can
choose the font and font size, and preview them in the area below:

Font - select a font from the list,

Size - select a font size from the list.

ConceptDraw DIAGRAM User Interface Reference © 2024 CS Odessa corp.
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Spell Check tab

Hew
Template Setup Dutch m’ -
Open ] Englsh {Linised Krodan)
’ [] Engish (Lested States)
Recent £ French {France)
e 5 ] German (austria)
Sxve b German (Germany)
e F] Dtakian (Ttaly)
Save AL ] 1

[ Lithisarian (Lithuaria)
import E Poksh (Polard)

£ Portuguese (araal)
Export - £] Portuguese [Portugal)

|1 Romanian (Romana)

[] Fussinn (Russin)
Libsary ] Spanish (Spain, Intermatonsl Sart)

] Spanish (Spain, Traditonal Sort)
Pant _ Swtcsh (Sieden) o

wia Email
Clase
Apply 2.3 Canced

Properties

Optians

Put a tick in front of the languages you use in your document for correct spell check.

ConceptDraw DIAGRAM User Interface Reference © 2024 CS Odessa corp.



Toolbar Tour

File

Template Setup

Template Setup

17

This tab contains settings of the default template. Starting with the New document and selecting the
Default document option, you get the workspace corresponding to these settings.

Printer and Page Setup

Here you can set the print settings for the document, and select the size and orientation of pages in the
current document as well as in all further new documents.

New
Ternplate Setup
Open

Recent

Save

Save As
Import

Export

Library

Print

Send via Email

Close

Properties

Options

Template Setup

Printer and Page Setup

Units, Scale, Snap and Other Setup

Printer and Page Setup

Setup printer paper, document page size, document fit, and paper justification settings.

Choose prefered units system or make custom settings below

%) US Drawing Setup
Metric Drawing Setup
Custom Setup

Choose Printer Paper

Size Letter -

Orientation  (£) Portrait Landscape

Printer Setup

Choose DocumentPage —

Size Same As Printer Paper Size -

Orientation () Portrait Landscape

Set Print Scale

Set Document Justification on Paper

| Document Page

| Printer Paper

Click on Ok button will apply this settings
to all next new documents as default.

ConceptDraw DIAGRAM User Interface Reference

© 2024 CS Odessa corp.



Toolbar Tour

File

Template Setup

Units, Scale, Snap and Other Setup

18

Here you can set measurement units and scale. The grid and snap options can be also set here. All
settings will may by applied to the current document as well as to all further new documents.

New

Template Setup

Template Setup
Printer and Page Setup

Open

Recent

Uniits, Scale, Snap and Other Setup
Save

Save As

Import

Export

Library

Print

Send via Email
Close
Properties

Options

Units, Scale, Snap and Other Setup

Setup Units, Scale, Snap and Show appearance settings.

Units of Measure

14

Scale

4

‘1:1

[1in |= [1in

Snap and Show appearance settings

[ Show Grid

[ show Object Dimensions
[#] Turn Rulers On

[ show Page Breaks

Zoom Wihole Page -

["]Enable Snaps
Angles Ruler Subdivisions
Geometry Shape Alignment Box
Grid Shape Handles
Guides Wertices

Connection Points

Glue to Guides

Click on Ok button will apply this settings
to all next new documents as default.

ConceptDraw DIAGRAM User Interface Reference
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Print

Home Shape Document View Share

Mew
Print

Template Setup

Open Print

Recent

Save Print Preview
Save As

Import

Export

Library

Print

Send via Email

Close

Properties

Options

Print - send the ConceptDraw DIAGRAM document directly to the default printer without making

changes.

Print Preview - view the document and make changes to pages before printing.

Print Preview

Select printer % All Pages I 4

Brother DCP-20650M Prir = b
Print Options 3 Size

& Print Setup Pv Range 1-3 .

Print Range

Print: Preview and print document

Select Printer: Change default printer

Print Setup: Show Printer Setup dialog box

Options: Show/hide grid lines and background for printing
Range: Select the range of pages that you want to print
Size: Select the paper size

Y Y
& R & ®
Orientation  Drawing Print  Previous Mext  Close Print
- Justification™ Scale~™ Page Page Preview
Faper Preview

Orientation: Switch between portrait and landscape layouts
Drawing Justification: Select margins for current document

Scale: Select the print scale
Previous Page: View previous page of document
Next Page: View next page of document

Close Print Preview: Close Print Preview and return to edit
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Clipboard
Text Format

Solutions
Select
Tools
Flowchart
Panels

Editing
Clipboard

The clipboard group includes functions that enable you to copy and paste data.

Paste

-

\Q{ Fermat Painter

Paste - Paste Clipboard contents.

Paste Special - Activate Paste Special dialog.

Paste Special as Previous - Paste special into the same place as previous.
Paste in a Place - Paste object over the copied object.

4 Cut (Ctrl+X) - Cut the selection and put it on the Clipboard.
% Copy (Ctrl+C) - Copy selection and place in Clipboard.
“Format Painter - Apply formatting of a particular object to other objects on the page.

Text Format

You can change the format of text in a selected object using these text formatting options
Calibri -1

BIURASES==_58

=

A A A-HE-

Text Format Pl
Select the drawing object that contains the text that you want to format. Click the formatting buttons that
you want to use, or Right-click the selected object and use context menu to open Text Properties
dialog.

Solutions

Here you can access the content of solutions. Use the button . to open Solutions Panel.
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Select

To make changes to an object, or to a text within it, you need to select it first, and for some changes,
you need to select multiple shapes.
Here you can find a set of selection tools designed to work with the selected objects.

Tools

You can create your own custom objects by using the rectangle, ellipse, line and other drawing tools
from Tools group.

OAGIN 2

o= MK

Flowchart

Flowcharts are diagrams that show the steps in a process. Basic flowcharts are easy to create and,
because the shapes are simple and visual, they are easy to understand.
ConceptDraw DIAGRAM comes with a set of Elowchart tools designed to simplify flowcharts creation.

Panels

Access to Arrange and Format floating panels.

Ll

Arrange Format
& Size

Editing

You can perform text edits and substitutions of selected objects.

Ao s

Find & 5Spelling Change
Replace Shape~

] Open the Find/ Replace dialog box (Ctri+Alt+F)

A Check the text spelling.

You can change the selected object by another using the following options:
Selected Objects with Primary: Change the selected object to the primary object;
Selected with Library Object (Ctrl+Space): Change the object selected on a document page to the
selected library object;
Library Object with Selected (Ctrl+Shift+l): Change the selected library object to the object selected
on a document page.
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Format Painter

BOEOHE ConceptDraw DIAGRAM - [Concept] - Pagel] - 0o x
Home  Shape  Document  View  Share  Developer 0-@-a--85x
& ¥ cut . B P = P T - )+ )
1 Calib |n - A-m@ - 1 Select Shape ~ [} L - - - . j:& H >
ooy alibri AN A 3 P OADN & e = = S 3, i & o v %
U A" A = = 3t Solutions i Select Text S ED A ™\ ‘& Connector  Rapid  Rapid Oraw RapidDraw Chain Tree Clome Snap  Amange Format  Find & Spelling Change
BIUANA = OB~ . Draw Mode Library Mode Page Mode . & Size Replace Shape~

Clipbosd Text Format &

You can apply formatting of a particular object to other objects on the page using the Format Painter tool

. There are a few ways to use this tool.

Apply the Embedded Style to Objects

Format
- Style
Thems Basic Theme L]
-] @
< _ _
Text

1. Select one of the embedded styles in the Format panel.
2. Click the Format Painter tool ¢ .
3. Click a single object in a document, or select a group of objects with selecting frame.

Apply Formatting of Particular Object to Other Objects

v Fill
Type Gradiert -
B Jide

- ? B |1o0s 2
HE ™M 15
| Wl [ e
EL.™IFCOE
Ll b | L
~ Border
Type Line -
- 1 [
Fattem L =
Weight 10pt o
Comerrounding | Oin -
~ Shadow
Type Drop Shadow ~
- I a0
Angle 135deg =
Offset 0.175in =

Draw below all shapes

Select an object.

Copy the selected object (Ctrl+C).

Click the Format Painter tool <.

Click a single object in a document, or select a group of objects with selecting frame.

robd=
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Selection Tool :2! is active by default.

To select a single shape, point the Selection tool to the object. When the pointer turns into a four-headed
arrow, click the object. Green handles and the shape functional buttons appear on the shape when you
select it providing you with quick access to some operations that can be carried out with the selected
object. The yellow control handle is intended for the object's text shifting. Some complex objects are
supplied with additional control handles used for changing the positions of parts of objects relative to
each other.

-
W M}e

When you want to change a number of objects, you can select multiple objects to work with them all at
once. Point Selection tool to the object. Place the pointer above and to the left of the objects you want
to select, and then drag to create a selection area around the objects. After you select the shapes, you'll
see green selection handles around the primary object. Other objects will have blue selection handles.

ConceptDraw DIAGRAM provides several tools for selecting objects. Knowing how to use each tool
makes working with objects easy.

ki - Select Next Object - Select the next object following the order of
Select Next Object creation.
Select Previous Object Select Previous Object - Select the previous object following the order
BF Select Al Ctrl+A of creation.
Select Connected Objects Select All (Ctri+A) - Select all objects on the page.
Delete Selected Object(s) Select Connected objects.
:j: Delete Selected Link(s) Select all objects that are connected to selected object.
p Eyedropper Ctrl+0

Delete Selected Objects - Delete the selected objects.

Delete Selected Links - Delete Selected Connectors.

Activate Eyedropper tool. The Eyedropper tool is used to sample a color
from an image to use this color further.

Text Selection Tool
Activate the Text Selection tool when you need to edit a text in ConceptDraw document.
3O [ Click the mouse once to activate the edit mode

g = [ Double-click to select the whole word.
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View  Share  Developer
“n JJALA-mT- . [Biselectshape - |0 A 3 N, 2

U AA EE S = =_ it Solutions §iSelectText O ®E A ™\ ‘& |Connector  Rapid

You can customize your drawings by adding yourself-drawn objects, text, or comments using Tools.

[ ]
A

Y

"'m
Yo

P
\J

w A N

Rectangle (Ctrl+7) - Click in the upper left corner of where you want to place your
rectangle and drag to the lower right corner to define the rectangle.
To draw a square, hold the Shift key down while dragging down and across the screen.

Text Box (Ctrl+2) - Insert, remove and resize text. Double-Click or press F2 to start text
edits

Callout - Click in the upper left corner of where you want to place your callout and drag to
the lower right corner to define its shape.

To draw a square, hold the Shift key down while dragging down and across the screen.
Use Action Menu to hide all callouts

To show all callouts, go to the Layers panel and switch on the "Comments" layer
visibility.

Line (Ctrl+3) - Draw straightline.

Spline (Ctrl+6) - Draw a freeform line.

Ellipse (Ctrl+8) - Click in the upper left corner of where you want to place your ellipse and
drag to the lower right corner to define the ellipse.
To draw a circle, hold the Shift key down while dragging down and across the screen

Title Text Box - Add pre-formatted titles and headings.

Direct Connector - Draw Direct Connector between objects.
Click on the object you want to connect and drag to other object to connect it.

Arc (Ctrl+5)

Edit Vertex - Activate this tool to see the vertices of the object. You can change the
form of object by dragging the vertex. Drag the vertex where you want it and then
release the mouse button.
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Rapid Draw & Flowchart
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B Copy ) = 1
U A* A, EET T ™= =|_ Jit Solutions § Select Text = A Connector _ Rapid R Spelling Chang
& FormatPaimer B T A’ = 3 A% " D e 9 Shnge

ConceptDraw DIAGRAM makes it easy to connect objects in your drawing. You can use one of the the
Connector tools. To connect elements using this tool, drag the connector from one connect point to
another. Direct Connectors are straight lines from the point of origin to the point of contact. Smart , Arc,
Bezier and Curve Connectors are drawn very similarly to Direct Connectors.

(m
E Direct Connector -EI Arc Connector
AN /N
\\‘\ \\
| E— N

< . i AN T ) ug ,_\]

~ J l_ t\

+ o k&

Activate Rapid Draw mode for selected object(s).

1]?[)

_

g1 Activate the Chain Connection Mode. Consistently connect selected objects with
Connectors. New object will be automatically connected to selected one. You can
change the connector's appearance using the Eormat panel.

o Activate the Tree Connection Mode. Connect selected objects with Connectors in a
tree structure. New object will be automatically connected to selected one. You can
change the connector's appearance Using the Format panel.

¢ Activate Clone or Duplicate tool. Clone tool allows to create the unlimited number of

zz copies of the selected object(s). Click any place of the document to insert a copy of the

= oiate -0 gelected object(s). Press Escape to turn off the Clone tool. Using Duplicate tool creates
one exact duplicate of the selected object(s).

}—Dr Activate snapping specified in the Snap&Glue Settings dialog.

Connectors can automatically route around objects already placed in your drawing. Also, you can insert
a new object directly in the connector path. If you want to do this, you need to check the corresponding
option in the General tab of the Options dialog.

Embed obijects into a connectar path | Embed objects into a connector path
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Rapid Draw
BoE"HE ConceptDraw DIAGRAM - [Concept1 - Pagel] - o
Home  Shape  Document  View  Share  Developer O-@-a -~
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& Format Painter

= it Solutions HSelectTet )@ A T\ 4 Connector
Clipboa .

BIUANAE Rapid Draw Rapid Draw| Chain Tree Clone Snap  Amange Format  Find & Spelling Change
- . &Size Replace Shape~
' Editing

Rapid
Draw Mode Library Mode Page Mode

" d Draw & Flowchart

Rapid Draw allows you to create professional diagrams in a few simple steps.

1. Open the desired library.

2. Add the needed object to the document. This will be the starting point for your diagram.

3. Activate Rapid Draw mode using one of the Rapid Draw buttons.

4. Click one of the small blue arrows that appear to add the next object in the proper direction. The
object appears and the connection is automatic.

5. Deselect objects in the current Rapid Draw object chain to disable quick drawing mode.

Choose the mode that is most suitable for your objectives.

Rapid Draw Mode is better to use when building a diagram consisting of identical objects. You can
create your diagram with just the keyboard. Use the combination Ctrl+Arrow keys to select the
direction.

B:vrrme Concaptlinw BLACRAM - [Concapt] - Bagat]
Home  Shupe  Doosmerk View  Sare Oeveloper
& o Tra— e P . I . e thupe » [ A 1% # 2F Fm P )
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£ 3| Mt atag e

[
(= T—

[

x
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Home

Rapid Draw & Flowchart
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Rapid Draw Library Mode helps you to quickly build a diagram from the active library.
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Sebitiotd [ Skt Teut [ l= I W~ T

Tomah

o

et

-]

g d
A 0 1 N O

o
=
Aagal
o Mode

ol D [Pt I
et

ibrary

P

g

Select Rapid Draw Page Mode to use only objects already added to the document page.
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Hzrmz  Ghapr [ecumes
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B Copy

& Fowmus Pabnin
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Fape
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Some ConceptDraw DIAGRAM libraries have built-in Rapid Draw features for their objects
For example, the Flowchart Rapid Draw library.

Beovr~HE Cosatept Dy DUAGRALL - |Centepal « Fagel]
“ Mome | Shepe  Dorertnt Wiew  Shaie  Decthapr
& ou Cabtei Ju A A AT . Bt - A DS 2 1 S S 40
I Copy ) x| & o - - ru o Fnzid
Pacie u = W == ife  Sohtion Leit Teal 5D Ty Ay Conned i Fapicd Dens Finzid Draw
. £ Forrrat Prrter BiU AAEED - A e T e - Daww HMQﬁ'i I.|=|F4r. Wiady Page Wads
Clgteard Totfemat Razid Depw & Firechar
¢ % | Mowdhans Rapid Deew -
Thapen A I
L J
TerFias &
L . ]
v et
Peccnu - ‘::" _,‘ .
Deuiian L) L] ™

.\.
CEoooEaEEE
YES | W%

Engage Rapid Draw object from a library and then hover your mouse over an object at a drawing page.
Directional arrows surround the selected object. Select the appropriate direction for your diagram. Then,
select the object you want to add. You can create your diagram with just the keyboard. Use the
combination Ctrl+Arrow keys to select the direction. Then, continue to press the same keys until the
appropriate object is selected and press Enter.
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Shape

BrinHR ConceptDraw DIAGRAM - [Hiring process - HR infographics] - o

“ Home Document View Share Developer o-e- -

T I TR < 8 S ApY R M
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Ed Shape  Custom
roup  Properties Properties

nsert Hypemote Inset  Backward Forward  Fitte  TextAuto  Text o 0 90'CW  LlaTex Point Runfround Edit Add Cut Operstions Crop  Group UnGroup
Picture Symbol... - - Tet  Expand Mode Bound Objects  Vertex Vertex Edge

Text Orientation
Point

Run Around Objects
Operations

Image Tool

Group

Properties

Insert

When working on a document in ConceptDraw DIAGRAM, you can perform some inserts.
[.] Insert picture from file
= Activate the Hypernote Panel
o
Ap Insert special characters that are not on your keyboard

Order

Here are object order tools. They help you control the placement of overlapping objects.
Ln Back: Mowe the selected object behind all other objects.
e Backword: Mowe the selected object one step back.

Gy Back Ctri+Alt+B

B Backward Ctrl+Shift+B
[y Front: Mowe the element in front of all other elements.
e Forward: Mowe the selected object one step forward.
©,  Front Ctrl+Alt+F

B Forward Ctrl+Shift+F

Text

Sevweral elements are inwlved in working with the text of an object.

-
T gy BT
T &

Fitto Tedt  Text
Text Handle Bound

Text Orientation

The text orientation buttons allow you to change the location of text with relation to an object. You can
shift and rotate a shape's text block.

Horizontal 90°CCW 90°CW
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LaTex

LA
X

Convert the selected text to LaTex code.

Point

Activate Connection Point tool. You can add any number of connection points to selected object as well
as to empty space in your document.

Run Around Objects

ConceptDraw DIAGRAM makes it easy to connect objects in your drawing. Connectors will

automatically route around objects already placed in your drawing. Use this button before you start
drawing when you would like to disable routing around objects. You can manage

Run Around mode Run Around mode
enabled disabled
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Operations

Sometimes the best way to draw a custom object is to take sewveral standard objects and combine or
change them to get the desired geometry. You can modify the Basic Shapes library objects with the
following operations.
/%= Edit Vertex: Activate this tool to see the vertices of the object. You can change the form of
object by dragging the vertex. Drag the vertex where you want it and then release the mouse
button.

I.E Add vertex: ConceptDraw DIAGRAM provides vertices on all its objects, but there may not be
enough for your purposes. You can add your own vertices. Select an object and use the Vertex
tool to add vertex to the shape. The cursor will look like a crossed circle. Left mouse-click to add
vertex to the shape. Change the shape form by dragging the vertex.

* 4

——————d

“}Q’ Cut Edges: Cut the object's edges.

Image Tool

i

You can crop the inserted image to remove any unwanted areas.

Q o o
r 'a'l

o | | @
L — - |
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Group

Group UnGreup  Edit
Group

You can Group and Ungroup selected objects.

Group Ungroup

The Edit Group button allows you to change objects within group using a special window for edits.

ConceptDraw DIAGRAM - [Flowchart - PagaBI» Edit Group (ObjID 321830)] |

A D H O HIH

Edit Add Cut Operations | Crop Group UnGroup  Edit
Vertex Vertex Edge - Group
Operatiors M| Image Tool Group

Properties

ConceptDraw DIAGRAM gives the opportunity to work with the object properties. You can change the
default object properties, and define your own, custom properties.
Shape Properties - Activate the Shape Properties dialog. This dialog is used to modify the
default properties of an object.
|I Custom Properties - Edit object's custom properties using the Custom Properties dialog or
define them using the Define Custom Properties dialog.

ConceptDraw DIAGRAM User Interface Reference © 2024 CS Odessa corp.
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w ) Ap
Insert Hypemote Insert
Picture Symbel...

ConceptDraw DIAGRAM - [Hiring process - HR infographics] - (u} x
Document View Share Developer M-®~-a_.8x
~ p = 5 M LA & o o @ ﬁ 5 = =]
= 6 B 8 8 % o ¥ H O
B BT T = Y R b s A i ral H ot
Backward Forward| Fitto  Text Auto Text | Horizontal 90°CCW 90°CW  LaTex Point Run Around Edt Add Cut Operations Crop Group UnGroup Edit Shape  Custom
. . ext  Expand Mode Bound Objects  Vertex Vertex Edge . Group  Properties Properties

Fit to text: Use the "Fit to text" button to Increase/decrease the size of the object
proportionally so that the text you have already typed fits the object's selection frame.

Lorem ipsum
dodor sit ¢
amet,
Condactefur
o a L o
IH?‘L.E: 1 Lorem ipsum dolor sit amet,
sad do consectetur adipiscing elit,
& i & sed do eiusmod tempor 4B
& | incididunt ut labore
it 1 et dolore magna aliqua.
labore v & »
et dolore
magna
aliqua.

Text Auto Expand Mode: Activate the "Auto Expand Mode" button before you start
typing text into the selected object, and the object's size will automatically expand to
fit the text you type into the object's selection frame.

o

[ ] L J
| Lorem ipsum dolor sit amet,
| consectetur adipiscing elit,
® sed do eiusmod tempor

incididunt ut labore
et dolore magna aliqua.
| FEEmEEEEEEEEr EEEEEmEmEEEm ]

— T .

Text Bound: Use the "Text Bound" button to restrict the visible portion of the text to
the object's frame.

Lorem ipsum

dolor sit

amet, o
consactetur

o, a 9 »
sed do | Laresm ipsasm
ersmod B dolorsit @
Lo Lo L --.aI“'EI".'--
incididunt ut STTeTTe
labore:

&t dolore

magna

aliqua.
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Operations

BruincHR ConceptDraw DIAGRAM - [Rapid_Draw - HR infographics] - =] x
“ H Shag Document View  Sh Develope: o0-e _ax
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Herizontal 90°C
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Symbol. - - Text Expand Mode Bound Objects fetex  Edge p  Properties Properties

Union: Create an object from the perimeter of multiple overlapping objects. Apply the Union tool only to
shapes with enclosed geometry.

. T

Before « + = After
Combine: Combine the selected objects into a solid multi-component object.

Before =« « + After
Fragment: Cut out the overlapping portions of multiple shapes based on intersecting lines with primary
shape in multiple selection.

. T

Before After
Difference: Divide multiple objects into smaller parts based on intersecting lines or overlap and cut out
the overlapping portions.

P R

* " Before After
Subtract: Create an object by subtracting from the primary selected object the areas where subsequent
selected objects owverlap.

“ Before ¢ s»  After
Extract: Create an object by subtracting from subsequent selected objects the areas where the primary
selected object overlap.

P R

~ " Before After
Intersect: Create shapes from the areas where multiple shapes overlap with the primary selected shape.
a " s
* " Before cer After

Separate: Separate combined objects.
Section: Create multiple shapes by cutting the selected shapes along the cut line created with the Line
tool. The Line should be a primary object in the selection.

- Before After
Join: Join selected objects into a single shape, if they are unclosed figures. For example lines, arcs
e.t.c. If they are closed figures such as rectangle or circle, this command will act the same as the
Combine command.

Before . After
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Convert to LaTex

[ BN Ealalal: ConceptDraw DIAGRAM - [Hiring process - HR infographic

“ Home Shape Document View Share Developer
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Insert Hypemote Insert Backward Forward Fitto  Text Auto Text  Horizontal 90°CCW 90°CW | LaTex Point Run Around Edit
Picture Symbol... » - Text Expand Mode Bound Objects Vertex

If you want to enter mathematical notation, you can use an embedded LaTex plugin.
LaTeXis a markup language and typesetting system designed for typesetting scientific texts.

1. Select an object.

2. Insert a LaTeX snippet.

3. Exit the text edit mode and activate the selection mode.
4. Click "Convert to LaTex".

You can insert an inline formula by typing the equation inside $..$ For example:

o ® ]
\text{
® The mass-energy equation: }\\ e
Se=mc”*25
bt @ .

LaTex Snippet

Q L J »

o The mass-energy equation:
&= mﬂz

Result
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To obtain a numbered formula you need to use the {equation} environment. For example:

T ®

\begin{equation}

R(t)= A\left(\frac{E_0}{\rho O}\
® right)*{1/51"{2/5}
\end{equation}

¢ G-

LaTex Snippet

®

Q@ _1'm®

1/5
Rit)y=A (ﬂ) £33

)

--$°"

Resalt

ConceptDraw DIAGRAM User Interface Reference © 2024 CS Odessa corp.



A matrix can be created using the matrix environment. For example:

[ T [
A_{m,n} =
\begin{pmatrix}
a {1,1} &a {1,2} & \cdots & a_{1,n} \\
a {2,1} &a {2,2} & \cdots & a_{2,n} \\
® \vdots & \vdots & \ddots & \vdots \\ [*
a {m,1} & a {m,2} & \cdots & a_{m,n}
\end{pmatrix}
L # »
LaTex Snippet
e ® »
(ﬂl 1 412 *f"l,n!M
dr| Q> as p
. AH‘F,H = : M : .
A am,Z Uy n
L} !
@ [ [
Result

Detailed information about LaTeX syntax can be found here:
https://en.wikibooks.org/wiki/LaTeX/Mathematics

37
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Add Delete Page Go to
Page Page~ Navigator

ConceptDraw DIAGRAM - [Concept] - Pagel]

Document View Share

[ B ; A B width 8.50in - | I Adjust to Content —c]_—

L 35 LT R | = -
W * 1B Height in = | I Size|Same As Printer Paper =
Page2 -

The Document tab provides the options to set multi-page document visual attributes.

Page
Manage
.

+
X

Page
Navigate
4 4 P
Go to: | Paged -

Page
Backgrou

nd

4

.--;J

i,

B4
Page
Size

rt
v

¥ Width 1L58in -
I8 Height|  7.96in =
] Lock Preportions

I Size|Same As Printer Paper ~

Add page: Add a blank page at the end of the document

Delete Page: Delete page from the document

Page Navigator: Activate Pages panel

Page navigation controllers: Buttons to scroll pages

38

Create Set this Page Choose Orientation Snap & Grid an
Background ~ as Background~ Background~ v| Lock Proportions Glue™ Ruler

Create Background: Add new page and set it as background page for the current

page or for all pages.

Set as Background : Set the selected page as a background to other pages. By

default, the new page is not a background page

Choose Background: Assign a background for the selected page from a list of all

document's pages. By default, the new page has no background

Orientation: Switch page between portrait and landscape layout.

Width: Change page width.

Height: Change page height.

Lock proportions: Keep page proportions when changing page size.
Adjust to Content: Apply the page size to fit page content.

Size: Select a page size or a display size using the drop down list.
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Settings ConceptDraw DIAGRAM comes with visual assistants to help align and structure the
elements in a drawing so that it looks good both on-screen and in print. The visual aids
include rulers, grids, and guides. The Settings section contains a button for quick access to
the control dialog of grid attributes. Also, here you can access the dialog to specify snap and
glue options.

Snap&Glue (Ctrl+Shift+U): Open the Snap&Glue dialog. Press and hold ALT to switch off
snapping when drawing or moving objects.

i Grid & Rulers (Ctrl+Shift+G): Open the Grid&Rulers dialog.

Connectors Routing

Mo Change the type of connector crossing.

I Square Square

e Arc Arc

M- 2 Sides Triangle

S 3 5ides Trapezoid

== Gap Dash line

T Change the layout of gap between connectors

2 Horizontal Horizontal layout
B Vertical Vertical layout

+ Mo Gaps Crossing with no gaps




View
. N al = RES ConceptDraw DIAGRAM - [Concept] - Page?] -
Home Shape Document View Share m-e -

Pages Layers My Libraries  Arrange Format Advanced Info
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Y = . - e -
at oo L o o | Rulers Page Breaks @os =
# N 8 4 e e @ue e B O

Shape Sizes
% - Panels  Window
ConceptDraw & Size v| Guides |v| Shape Controls Zoom 38% . -

Side Panels View Zoom Panels & Windows

Side

Panels

Quick access buttons to the most frequently used floating panels

* Pages — Activate the Pages panel
’ Layers — Activate the Layers panel
i’ My ConceptDraw — Activate the My ConceptDraw panel
% Libraries — Activate the Library panel
% Arrange&Size — Activate the Arrange&Size panel
ﬁ Format — Activate the Format panel
]&[ Advanced — Activate the Advanced panel

€ nfo — Activate the Info panel

@ o3 X

View ConceptDraw DIAGRAM document window has visual assistants to help align and structure the

elements in a drawing so that it looks good both on-screen and in print. The View section
contains visual assistants controls.

Rulers — Show/Hide rulers

Grid — Show/Hide Grid

Guides — Show/Hide Guidelines

Page Breaks — Show/Hide Page Breaks

Shape Sizes — Show/Hide an object dimensions using editable size boxes
Shape Controls — Show/Hide an object functional buttons.

Zoom

#_ Zoom In  Zoom in on the document.

=, Zoom Out Zoom out of the document.

Zoom to
Whole . .
| Zoom document so that the page fills entire window
ik Page
(Ctrl+Shift+
0)
EE Zoc?m to aIIZoom document so that all objects are \isible
Objects
k Zoom Box Zoom in on the document so that selected area fills entire window
Press and hold ALT to Zoom out of the selected area.
1, Scroll Activate the Scroll Hand tool that allows one to easily move the page.
“~ Hand Hold on the right mouse button to move page.
- Zoom Choose a standard level within the 50% - 400% range, or set "Whole Page

'Page Width" or "All Objects".

"
’
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Panels & Windows

Panels — Clicking the button will close all currently opened Eloating Panels. The next click will

cancel the closure.
To open/close particular panels, use the drop-down list.

Output

Library

Solutions

Pages

Layers

Arrange & Size
Format
Hypernote
Presentation

Info

Customn Properties
Advanced

Text

My ConceptDraw

EmrEleO«TnmEs@EAQA

Colors
Status Bar

Restore Panels State

Output — opens the ConceptDraw Basic Editor window
Library — opens the Library panel

Solutions — opens the Solutions panel

Pages — opens the Pages panel

Layers — opens the Layers panel

Arrange & Size — opens the Arrange & Size panel
Format — opens the Format panel

Hypernote — opens the Hypernote panel

Presentation — open Presentation panel

Info — opens the Info panel

Custom Properties — opens the Custom Properties panel
Advanced — opens the Advanced panel

Text — opens the Text panel

My ConceptDraw — opens theMy ConceptDraw panel
Colors — referred to the Colors panel on the bottom of application window.
Status Bar — shows the Status Bar

Restore Panels State — restores the default Panels view

i3 Windows — Clicking the button will open the drop-down menu associated with document
windows order. Allows you to open, close, and arrange documents that are currently opened in different

windows.
*= New Window
Cascade Windows
B Tile Windows Horizontally
D] Tile Windows Vertically
|:|° Close Ctrl+W
P Closeal

New Window — open a new window containing the current document.
Cascade Windows — cascade arrangement of opened windows.

Tile Windows Horizontally — horizontal arrangement of opened windows.
Tile Windows Vertically — vertical arrangement of opened windows.
Close (Ctrl+W — close an active window.

Close All — close all open windows.
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Visual Assistants

ConceptDraw DIAGRAM provides visual assistants to help align and structure the elements in the
drawing so that it appears to look good both on-screen and in print. The visual aids include rulers, grids,
guides, page breaks, shape size boxes, and shape controls.

Rulers

Rulers help in showing the real sizes of scaled elements in a diagram according to the Units and Scale
settings. They help place objects to attain a consistent and clear look. Rulers can be switched off or on
with a simple checkbox in the View section of the View tab.

When you mowve a cursor within an object you will notice that there are 2 red dash lines on both the
vertical and horizontal rulers. The red dashes indicate the position of the cursor relative to the object.
When you drag it vertically or horizontally, the dashes help position the object exactly at the place you
need.
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Grid

Grid helps to align shapes within the drawing and can also be an important measurement tool. The grid
comprises of square boxes of a defined area, which can be adjusted. Therefore, the grid helps you hawe
an estimate of the likely area occupied by an object, which allows you to size objects as needed.

To turn grids on or off, check or uncheck the Grid checkbox in the View tab. You can also customize the
size of grid cells To do so use a Grid & Rulers dialog where you can adjust parameters such as
subdivisions in a grid, the horizontal and vertical spacing, and color.

3

q ) =} 7
||||||||||||||||||||||||||||||||||||||||||

I
»
o
»

1111
——
-

12

Lo rnr | F o
/
AN

11




44

Guides

Guides help in orienting different shapes of the diagram properly. You can create any number of guides
from both the vertical and horizontal rulers. To create a guide, simply drag a line from either the vertical or
horizontal ruler. Guides are represented by lines, which appear thick when selected. You can delete a
guide by simply selecting the guide and pressing the Delete key on the keyboard.

To turn guides on or off, check or uncheck the Guides checkbox in the View tab. Use the Snap&Glue
dialog to snap an object to guides. Dragging a shape onto a guide will enable you to snap the object to
the guide. When an object is snapped to a guide, it moves along with the guide.
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Page Breaks

Page breaks show the borders of the printed document page set in the Print Setup section of the
document Properties. The actual page dimensions set in the Page Size section of document Properties
may not match the page settings for printing.

To turn page breaks on or off, check or uncheck the Page Breaks checkbox in the View tab. If it is
necessary that the dimensions of the document page completely match the dimensions of the page
when printed, choose the Same as Printer Size option when setting the page size.

ConceptDraw DIAGRAM User Interface Reference © 2024 CS Odessa corp.
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Shape Sizes

Shape Size boxes show the width and height of the selected object according to the measurement units
settings. To change the parameters of the width or height of an object, just change the value in the

corresponding box. To turn shape size boxes on or off, check or uncheck the Shape Size checkbox in
the View tab.

1500 2000 =00 3000 3500 Q000 qs00 SO00 S500 B0
|||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||

Q000 2500 000 00 2000 1500 1&5
[FTEE knew i PR ww i REET] Srawi RRTRE nwnll RTRNE by ARETH kawwl RRTHE b
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Functional Buttons

A set of function buttons becomes available when you select a single object. These buttons provide
quick access to some operations that can be carried out with the selected object. To show/hide the
functional buttons of the selected object, enable/disable the Shapes Controls in the View tab.

0

The Action button e
Some objects supplied in the DIAGRAM libraries can change their appearance, or behavior, thanks to
predefined actions. Such objects can be edited by using the menu which is called by clicking this

button.

e ________
: Add slice
: Remove slice
: Set slice number
! Hide values

®

e

The Hypernote button
Activate the Hypernote side panel to manage text notes and hyperlinks added to the object.

The Custom Properties button = .
Activate the Custom Properties side panel to view and edit the object's custom data.

ConceptDraw DIAGRAM User Interface Reference © 2024 CS Odessa corp.
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Functional Buttons

The Smart Connector button e

48

Activate Smart Connector. To connect objects using this tool, drag the connector a connect point of
another object. You can change the connector's type using the options provided in the Format side

panel.
Bl Format X
Format | Hypernote
.
* Style -
Theme Basic Theme -

Text Text
. 4 r
o e
* Connector Type
& w Iy Ty %
Direct Arc Bezier Smart  Curve

The Delete button o

Use this button to remove the selected object from a document page.

ConceptDraw DIAGRAM User Interface Reference

© 2024 CS Odessa corp.
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Share
. 2! H =Y ConceptDraw DIAGRAM - [Concept] - Page?] - O X
Home Shape Document View Share 0-@~-a_ax
o b N I g I
w 22 38R v @
Presentation  Send via PDF EP5  Graphic HTML M5 M5 Visio M5 Visio  SVG
file PowerPoint  (VDX)  (VSDX)
Panel Exports
Panel

>

Email

Exports

Presentation: Open Presentation panel

Send via email: Send a copy of the current document in an email message as an
attachment

Adobe Flash: Save document as Adobe Flash (SWF) file, using Flash Export Settings
dialog

PDF: Save document as Adobe Acrobat (PDF) file

EPS: Save document as Encapsulated PostScript (EPS) vector file

Graphic File: Save document as graphic file (emf, bmp, dib, gif, jpeg, jpg, png, svg, tif,
tiff)

HTML: Save document as HTML file

MS PowerPoint: Save document as Microsoft Office PowerPoint 97-2003 Presentation
(-ppt)

MS Visio (VDX): Save document as Microsoft Visio 2003-2010 Drawing (.vdx) file

MS Visio (VSDX): Save document as Microsoft Visio Drawing (.vsdx) file

SVG: Sawe document as SVG file
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Developer

Deweloper tab is used to operate with ConceptDraw Basic Script. It is disabled by default. Use the View
tab in the Options dialog to activate it.

Each ConceptDraw graphical object has a set of properties that define its appearance and possible
actions
There are two major ways to manage the graphic content of ConceptDraw DIAGRAM documents:

e Shape Parameter Table
e ConceptDraw Basic Script

ConceptDraw Basic Script is used to create and work with complex objects containing a variable number
of components, custom properties, and types of behavior. ConceptDraw Basic Script allows setting
interaction with other applications (run from the command line, invoke custom functions from external
libraries).

The application, document, page and even object can contain a ConceptDraw Basic Script. This means
that any document, page or object, can contain some program written in ConceptDraw Basic script.
Script at any level is compiled and run at start-up of the corresponding object. Initially, the application is
loaded. The primary level of the script execution is the Application level. When you download a
document, first run a Document script, then Page script and finally the Shape script.

B VoM e ConceptDraw DIAGRAM - Quarter Sales Revenue for Top 10 Products by Categories - a X
Heome Shape Document View Share Developer o-e-»
B = =1 K Cut(CrdsX)  Gote: |34 [z5=3] = p— m— |
ER &0 5 | [y A hL 5 OHS ®
8 Copy (Ctrl+€) 4l First line
Open Save Compile Run Select Find & Replace ape Page Document Application  Output Document Arrange Close Basic
Script Script*  Seript Al B Paste(Ctiev) I Lastline (Ctrl+F) Script™ Script®  Script®  Script®  Window® Window . View
Script Edit ConceptOraw Basic View
. . CDBasic - Shape - Quarter Sales Revenue for Top 10 Products by Categories : Category 1:.. — 0O X
- 1 #INCLUDE "DSFunctions_2014.cdb™ ~
Category 1 C 2
3 declare sub SelectDataSourcel()
4 declare sub SetData(shp 25 Shape)
5
Category 1 Products Sales Revenue 6 declare sub Addsector(shp as Shape)
H Products Sale Revenue, $US Millions 7 declare sub RemoveSector{shp as Shape)
! 8 declare sub CalcSumi)
23 9 declare sub SetSectorsNumber()
16 10 declare sub Percentage (shp as Shape)
11
24 | 12 static num as integer ‘current col
T d 13
14
0.85 15 Dim CategoriesNum as Integer
16 'ConstFirstShpNum as integer =3
0.62 17
0.4 i 18 Sub SelectDataSource()
19 Dim Sh as Integer
12 20 sh = SetDatasource()
Product1l 43 21 I Sh >0 Then
22 thisshape.CustomProp(10).vValue =Sh
Product1) 39 23 thisshape.PropertyChanged(Cdpt_custom_value, 10)
Other Products 25 24 SetData(thisShape)
25 Endif
~ ||| 26 endsub )
Page List Category 1(1/6) 1514 || < >
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Shape Parameters Table

The Shape Parameter table provides the opportunity to work with a pre-defined set of object parameters
===

and properties. You can access it using the Power Edit button EI’ on the Developer tab.

With the help of the Shape Parameter table, you can define the logic of objects behavior, apply an

arbitrary appearance to them, set relationships between the appearances of different objects and create

composite objects. You can manage the tables sections using Insert Table Section and View Sections

dialogs.
B mHEE ConceptDraw DIAGRAM - UML i N =
“ Mome  Shape  Document  View  Share | Developer O-@-a
B B X cwin  Gor Bl EERE E E i)
B % o ! B B copyicon) 4 H | e Sn i ’—_ [ ) B ®
Sellﬁcl B Poste(ctey) I ch![&&:j: ]Iaee Pmer a‘a;e' s::gte' Dc;:gsnl n%:l'ulc;lllon ! o ana-\ge
Seript Ede ConceptDraw Basic
. UML eemposite structure diagrarm - Sale process - UML composite structure diagram = 0O x
. ']
' '
' '
Buyer | ~ Seller
Broker Saaaaaes s Producer &
i
) 0
., '
\\‘\% 0 . . ' v
| % e
Page Lis composte sauchure disgram . 4 ] ]
B =

evaPlEEPFESREERRISER
’_!usps!_meu:mms;l;sj

Im“
width 457.258902343794] Fligh

Height 235. 722705232283 Rigt
o | Leckink

Filled 1

Nams x ) & I} Je [o
151an Width's Heignt"0 5
2.Ellips #Tn Width*] Huight"0.5 Widih*0.5 [Heigm*o | _ELLIPSE_ASPECTID 5| _FLLIPSE_ANGLE 5]

S ElipiaTa T N T N L o [Fegm™s [ Rwse_sevecTin 5| LELUFSEANG

For more complex objects, objects with a variable number of child elements and custom
properties, as well as a predetermined behavior ConceptDraw Basic script is recommended.

ConceptDraw DIAGRAM User Interface Reference © 2024 CS Odessa corp.
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Modal Dialogs

These dialogs are mostly called from the menus, or by using the keyboard shortcuts. While this dialog is
open, you can't work with other dialogs or tools. As a rule, modal dialogs have sewveral standard buttons:

OK - closes the dialog and applies the changes.

Cancel - closes the dialog without applying the changes.
Apply - applies the changes without closing the dialog.
Help (?) - displays context help.

The settings are not applied until you click the OK or Apply buttons.
Color

Define Custom Properties

Edit User

Find/Replace

Flash Export Settings

Grid&Rulers

HTML Export Wizard

Image Properties

Insert Table Sections

Library ltem Properties

Library Properties

Login

Open
Page Properties

Paste Special

Sawve

Shape Properties

Snap and Glue Settings
Spell Check

Text Properties
View Sections

>
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Color

This dialog is used to set color for a shape, its text or other attributes.
You can call this dialog by choosing the Other... from the appropriate button of Format panel .

The Color dialog:

e -

Color @

Current: -

R {} 125
G (} 125
B (} 125
Al 0 %

[RGBSdﬁemE v] [ System. .. ]

7)) [ Ok ] [ Cancel ]

To choose the needed color, click on it with the mouse.

Current - shows the currently chosen color.
Old - shows the color being changed.

You can specify a color manually in one of the two available color schemes: RGB or CMYK. The
currently chosen scheme is shown in the drop-down list:

- RGB Scheme

- CMYK Scheme

The R(ed),G(reen),B(lue) or C(yan),M(agenta),Y(ellow),(black)K slide bars allow to change each
component of the color scheme.

Note: In the RGB Scheme the color components may range from 0 to 255; in the CMYK Scheme the
components are shown in percents and may range from 0 to 100

A slider allows you to add transparency to your objects in order to make them more attractive or if you
want to see objects located under. Mowve slider to the right to increase the transparency of the object and
to the left to decrease it.

System - calls the system color dialog.
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Define Custom Properties

This dialog is used to create, modify and delete custom properties of a shape. This dialog can be called
by clicking the Define button in the Custom Properties dialog or by clicking on Define Custom Properties
button in the Custom Properties panel if custom properties are not defined yet. The Define Custom
Properties dialog:

Drefire Customn Propertees o

[F 2 Fropesy 220

Trot: | Sing o
Forrmup!

Wi

Prompt

[ rwisibier [0 ety

Prrcetiza) | Ea

£ 3

L1} tasw Dt Cancel

The Properties section in the lower part of the dialog contains a list of custom properties of the shape. To
modify or view a property in the upper part of the dialog, click on its name in the list.

New - creates a new property and adds it to the list.
Delete - deletes the property, selected in the table.

Each custom property is described by the following fields:

Label - the name of the property. It's used when the property is referenced to in formulas or CD Basic
scripts.
Type - the type of the property, can have one of the following values:

String

Number

Fixed List

Variable List

Boolean

Note: The information about the type is used in the Custom Properties dialog: when entering values of
the Fixed List, Variable List or Boolean types you're offered to choose one from the list. Also information
about types can be used by CD Basic.

Format - contains the list of possible values for the properties that have the Fixed List or Variable List
types. The values are delimited by semicolon ";". For values of other types this parameter is ignored.
Value - indicates the default value,

Prompt - the text of the tip,

Invisible - specifies whether to show this property in the Custom Properties dialog,

Verify - if enabled, checks if the property has a value, and if it doesn't, the user will be asked to provide
one.
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Edit User

This dialog is used to edit user details. You can limit access to the document to authorized users only.

This dialog is called when you click the Add User or Edit User buttons in the Advanced tab of the
Properties dialog.

The Edit User dialog:

Edit User >

User: | Richard |

Pazsword: | sssssssss |

Confirm password:| sesssssss |

9 Cancel

User - the name (login) of the user.
Password - the password. It can contain any symbols. The password is case-sensitive.
Confirm password - enter the password here to confirm it.
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Find & Replace

This dialog allows you to search for and replace text in ConceptDraw shapes. The search can be
performed either in the current document, or in the documents on disk (including folders and sub folders).
You can edit the document without closing this dialog - it remains floating over the document, and you
can always return to it and search for the next match.

i

You can call the dialog from the Home tab button or by using the keyboard: Ctrl + F

Find/Replace dialog

Find and Replace X

Find what: | ~ | Find Mext

Replace with: | ~ | Replace

[ ]mMatch whole word [ | search badawards
[ Imatch case []search linked
[]search all pages

Replace all

In folder

Path: | v| Browse...

[ ]Lock in subfolders
) I Close

Find what - here you can specify the string to be found. You can either type the text, or select one of the
previously searched strings.

Replace with - a string with which the found string will be replaced.

Match Whole Word - search only complete words. For instance, if "leg" is being searched, the "leg"
world will be found, and "legion" and "legend" will be ignored.

Match Case - specifies whether to differentiate capital and small letters in the search.

Search All Pages - specifies whether to search on the current page, or on all pages of the document. By
default only the current page is searched.

Search Backwards - searches in reverse direction.

Search Linked - specifies whether to search in the hyperlinked pages and objects.

In Folder - search in all ConceptDraw located in the folder, specified in Path. All open documents that
are not in the Path folder are ignored.

Path - specifies the path to the folder, where the search will be performed. You can type it manually, or
choose by using the Browse button.

Look In Sub folders - specifies whether to search in sub folders of the folder, indicated in Path.

Find Next - finds the next match. If the match is found, the text editing mode is turned on and the found
text gets highlighted. If the In Folder or Search Linked options are enabled, and a match is found in one
of the non-opened documents, the document will be opened automatically.

Replace - replaces the found string with the string in Replace with.

Replace All - replaces all matches with the string in Replace with.
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Flash Export Settings

This dialog is used to configure the parameters of the resulting .swf file when exporting the document to
Macro media Flash format.

This dialog is called from the menu File /Export/Adobe Flash, or from the Share tab.

Flash Export Settings dialog

Flash Export Properties by

Slide Show: () Mone
(® Mouze click

() Timer

B zec

[ ] Use navigation buttons

© Corc

The Slide Show setting specifies when the next page of a multi-page document will be displayed:

None - only the first page is displayed.
Mouse Click - the next page will be displayed on a mouse-click.
Timer - the next page will be displayed in the specified time interval (in seconds).

Use Navigation Buttons the following navigation buttons will be inserted into the Flash file:
Go to first page
Go to previous page
Go to next page
Go to last page
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Grid&Rulers

This dialog is used to configure the view of the grid and the rulers. This dialog can be called from the

Grid&Rulers button on the Document tab, or with the keyboard: Ctrl + Shift + G
Grid & Rulers dialog

Grid & Rulers x
Rulers Origins
Grid Origins

Grid Spacing

Horizontal: | Normal ~| |0.5in

Wertical: | Mormal ~| | 0.5in

Grid Color

Color: -
Alpha: ] =]

(7)) OK Cancel Apply
The Rulers Origins -sets the starting point (origin) for the rulers. The origin represents the horizontal and
vertical offset relative to the upper left corner of the page.

Horizontal - horizontal offset. The possible range is -320 mm to +320 mm.

Vertical - vertical offset. The possible range is -320 mm to +320 mm.
The Grid Origins -sets the starting point (origin) for the grid lines. The origin represents the horizontal and
vertical offset relative to the upper left corner of the page.

Horizontal - horizontal offset. The possible range is -320 mm to +320 mm.

Vertical - vertical offset. The possible range is -320 mm to +320 mm.
The Grid Spacing section specifies the size of the grid cells.
Horizontal - sets the width of the grid cells:

Normal

Fine

Coarse

Fixed.
The Fixed option allows to input a custom value within the 0 mm to 320 mm range.
Vertical - sets the height of the grid cells:

Normal

Fine

Coarse

Fixed
The Fixed option allows to input a custom value within the 0 mm to 320 mm range.
The Grid Color section specifies the grid color and alpha channel settings of the grid.
The Alpha channel control§ the transparency/opacity of a gr(i‘d color.

Grid & Rulers x ! Grid & Rulers
I
Rulers Origins ; % Rulers Origins e [ ) PY
Horizontal 0 Horizontal: I u
Grid Origi Grid Origins | gprra Ao
T ¢ ) )
Horizont tal: \an ‘ Horizontal:
Grid Spacing Grid Spacing
Horizontal: [Normal ~~ ~|  0.51 Horizontal: [Nermal | 0.5
Vertical: [Normal  ~| 0.5 Vertical: [Normal | 0.5
Grid Color Grid Color
aipha: [ 1l # Alpha 13
9 oK Cancel Apy 9 oK Cancel T hppl

Maximum of Opacity Maxomum of Transparancy
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HTML Export Wizard

This dialog is used to set exporting parameters for HTML. Access dialog from the Export item in the Eile

menu
HTML Settings *
-
[B]

[ |

[ -
i i
| |
Agua Agua b

Ao

[

-
i
|
Ascet i

Process linked ConceptDraw documents
] Export current page only
[ ]Export pages as images
Open resulting document

There is a gallery of templates in the top part of the dialog. To choose a template make a click on its
icon. To export the current document with the default settings make a double-click on chosen template

icon.

Process linked ConceptDraw documents - process all linked ConceptDraw documents like the

current document, so you will be able to open them as regular HTML files from the exported HTML file.
Export current page only - exports only current page of the document.
Export pages as image - exports the content of ConceptDraw document as *.png image inserted into

html page

Open exported page - opens exported HTML file after export using default Web-browser.

ConceptDraw DIAGRAM User Interface Reference

© 2024 CS Odessa corp.
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Image Properties

This dialog is used to configure export settings of ConceptDraw shapes to other graphic formats. This
dialog can be called from the Eile / Export / Graphic File menu, or from Share tab. Graphic File dialog.

Image Properties X

Format |PNG - Portable Metwork Graphics -
Image Size
*) Original size
Use document zoom
High quality

Fit to size

000

1080

|l x 748 > | pixels

(1]}

Pixel density 96 > | ppi

Export

) Whole page
All objects on page
| Use antialiasing

Use transparency

) Cancel

In the Image Size section, you can choose one of these options:
Original size - the shapes will be exported in their original size, regardless of the current zoom lewvel.
Use document zoom - the shapes in the graphic file will bfile woulde of the same size as they appear
on screen (at the current zoom level).
High quality - choosing this option, you'll get the best quality image. Please note, that the size of the
increase. We recommend to use the option for printing.
Fit to size - this option lets you assign custom dimensions to the picture - specify the width and
height in pixels.
Pixel density - this option lets you change a pixel density (PPI).

In the Export section, you specify which shapes will form the image in the graphic file:
All document pages separately - create a separate graphic file for each page of the document.
Whole page - to export the entire page with all the shapes which are within the page.
All objects on page - all the shapes which are on the page and outside it. The image size will be large
enough to fit for all shapes.
Selected objects - only the selected shapes from the active page. The image size will be equal to
the total bound of all selected shapes.
All document pages - select when export to animated GIF.
Time interval (GIF) - set the time interval to show the animated GIF slides.
Quality - for JPEG format you can also specify image quality: by using the slide bar, you can set the
quality within the range of 1% to 100%. Note that better quality increases the file size.
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Insert Table Sections

This dialog is used to insert new sections in the Shape Parameter table.

ocvaRreEERR=EaEEE:S

(==

= =

Height+Child380.TextHeight+Child380 TextWidth*0.7*variables ¥5

Insert Section dialog:

Insert Sections X

Avalable Sectors:

Geometry

Control Handes

Gt

[ variables

Actons

[ Custom Properties
Text

[atasources

Data

RapidDraw Gbject

® G

Width eoo0 Fliph FALSE L
Height oo FlipY FALEE
Angle 0 LocFinX Width*0.5
GPinX 142264 LocPin® Height*0.5
GPinY 1211.21
b b XOyn FOyn MEBEehaviour YBehaviour Comment
1 -1% Controls Y2+(Child44 Controls X1 Controls 1 o = IF{CustomProp¥al| "Comment”
2 Width*0.5 Height+Child220 Tex| Controls X2 Controls ¥2 o =_IFiCustomProp¥al| "Categories "
3 -0.40in*DocScale | Height*0.5 Controls X3 Controls ¥3 a = IF{CustomProp¥al| "Walues"
q Width*0.5-TextWidt| -TextHeight*0.5-50 | Controls X4 Controls ¥4 o =_IF{CustomProp ¥al| "Heading"

In the dialog you can choose which sections are to be added in the table:
Geometry - adds a new Geometry section. It's available for all shapes except groups.
Control handles - adds the Controls section, that describes control handles. A shape
can have just one Controls section.
Connection points - adds the Connection Points section, that describes connection
points. A shape can hawe just one Connection Points section.
Variables - adds the Variables section, that describes user-defined variables. A shape
can have just one Variables section.
Actions - adds the Actions section, that describes user-defined actions. A shape can
have just one Actions section. The first 15 actions are available from the shape's context

menu.

Custom Properties - adds the Custom Properties section, that describes user-defined
data. A shape can have just one Custom Properties section.
Text - adds the Text section, that describes the text properties. A shape can have just
one Text section.
Data Sources - adds the Data Sources section, that describes the three-side data
sources properties. A shape can hawe just one Data Sources section.

Data - adds the Data section, that describes the Data properties. A shape can have just
one Data section.
Rapid Draw Object - adds the Rapid Draw section, that describes the Rapid Draw

properties. A shape can have just one Text section.
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Library ltem Properties

This dialog is used to view and set the properties of library shapes. You can call this dialog by clicking
Properties in context menu of Library object in the Library window.

Library 1 x

€ 2| UMLactvity.. ~
”
1
[, Mew Library
Ad P Close Library
B Close All Libraries
B
M Savelibrary as...
Decisior () Send Library via E-mail..
Show Library File Location

P& Library Properties...

Add Section

Time eve Cut

Copy

‘: Delete

Replace
Send sig Change icon

Move to Section »

ol S

View as [cons
Receivesi o View as |cons and Text

View as lcons and Text Right

Thé Library Item Properties dialog:
Library ltem Properties X

Mame: | Action |

Prompt: | UML Activity diagram

Keywords: | action, activity, uml, diagram|

L) Cancel

Name - contains the name of the library shape.

Prompt - contains a brief description of the library shape.

Keywords - contains comma separated keywords - words or phrases that can be used when searching
the library object.

These properties are displayed when you position the mouse pointer over a shape in the library. The ltem
name appears as a tip over the shape, and the /tem prompt is shown in the status bar.
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Library Properties

This dialog is used to view and set library properties. You can call this dialog from File / Library /
Properties or from the context menu in the library window.

< » | UnLacivine. -

-~

L )
Mew Library
LE| Close Library

=S

i)

BP Close All Libraries
N

B

5

Save Library as...
Decisior Send Library via E-mail...
Show Library File Location

J Eh  Library Properties...

Add Section

Time eve Cut

Copy

I: Delete

_ Replace
Send sig Change icon
Move to Section »
Properties...
View as [cons
Recelvesi &  View as lcons and Text

- View as lcons and Text Right

Thé Library Properties dialog:

Library Properties d

Title: | UML activity diagrams |

Keywords: | UML activity diagram symbols |

Author: | ConceptDraw PRO team |

Company: | €S Odessa |

Description: | This vector stendls library contains 37 symbols for drawing UML
activity diagrams.

LD Cancel

Title - the name of the library.

Keywords - contains comma separated keywords - words or phrases that can be used when searching
the library.

Author and Company - information about the creators of the library.

Description - Short description of the library content.




Page Properties

This dialog is used to view and the page properties.

You can call this dialog from the Page Navigator menu (View tab/Panels/Pages)

Pages 0 %
Pages | Solutions
~
T -
e~ =}
F O —
P . e— |
T Iy AddPage.
& == Insert Page
Marketin Duplicate Page
Rename Page
Choose Background [
T
Set as Background for b

= g Remove Page
'. View as ¥
Adjust to Drawing Contents

Properties...
Internat

Create new document

The Page Properties dialog:

Page Properties =
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Title: | Marketing infogram

Description:
Visual display of a market research data

Cancel

Title - the name of the Page
Description - Short description of the page content.
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Login

This dialog asks user login and password for documents with protected access. It appears when you try
to open a protected document. If such user name and password are not authorized to view the
document, the document is not opened.

The Login dialog:

Login x

|ser: | Richard |

Fassword: |-|||-|||- |

o oot

User - the name (login) of the user.
Password - password.

Note: To protect the document and specify authorized users, use the Properties dialog, the Advanced
tab.
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Open

This dialog is used to open ConceptDraw documents and to import documents of supported formats.The
dialog can be called from the Eile / Open menu, or by using the keyboard: Ctrl + O. The dialog is also
called when importing files .

Open dialog
. Open x
&« v » ThisPC » Documents » My ConceptDraw v (4] D Search My ConceptDraw
Organize » New folder = O @
I Desktop ~ - Audit_flowchart_multipage ~
+ = ConceptDraw Document
‘ Downloads =il 23ke

| Documents Business process diagram BPMMN

=/ Pictures 2.0
| ConceptDraw Document
cons
- Business process diagram BPMN "~ _
lcons &m g Z
Sample maps = in ConceptDraw Document 1
i - . LA
‘Web Export - Causes and Effects Analysis 1 - P "' '
2% ConceptDraw Document
@ OneDrive =l 626 KB
. - Computer network diagram e .
3 This PC 2= ConceptDraw Document
_J 3D Objects =l 977 MB
[ Desktop - Concept map
= + = ConceptDraw Document
| Documents =il 205K N
‘ Downloads v € > IR T
File name: | Business process diagram BPMN 2.0 v| All ConceptDraw Files (*.cdd, *, ~

In this dialog you can choose to show only files of the desired type. In the list, choose the document
you want to open, and double-click it with the mouse. To select more than one document, hold down the
Shift or Ctrl keys.

Open - opens selected documents.
Cancel - closes the dialog.

Note: By default, this dialog shows only ConceptDraw DIAGRAM files. To show files of other types,
choose the corresponding type in the drop-down list.
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Paste Special

This dialog is used to insert various objects from the Clipboard into a ConceptDraw document.
This dialog can be called from the Home/ Paste Special menu.
The Paste Special dialog:

Paste Special >
Source:  Unknown Source | QK |

Re: Cancel
@ Paste Device Independent Bitmap

Ficture (Metafile)
ConceptDraw Object
Paste Link Display As lcon
Result

Inserts the conterts of the clipboard into your

document as a device independent bitmap.

Source - indicates from where the object was copied.

As - offers available formats in which the object can be pasted. Depends on the current buffer content.
Paste - the object will be embedded into the ConceptDraw document and will be stored together with it.
Paste Link - pastes a reference to the object, rather than the object itself. When the source file is
changed, the object in the ConceptDraw document will be changed respectively. Only a link to the object
is stored with the document.

Result - explains what will happen when you insert the object in the selected format.

Display As Icon - specifies whether the object should be displayed as icon, or in its original form.

Result - explains what will happen when you insert the object in the selected format.
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Save

This dialog is used to save documents, templates, workspace files and files of other formats, exported by
ConceptDraw. This dialog can be called from the Eile menu by the Save (Ctrl + S) item (if you sawe the
file for the first time), Save As (Ctrl + Shift + S), Sawe As Template, commands or by using the
keyboard. This dialog is also called when you export files.

Save dialog

Save As >
i

A <« Documents » My ConceptDraw w & Search My ConceptDraw

Organize « Mew folder Sl (7]

¥ Downloads 2 ] &
MINDPMAP Files
|| Documents .[ :

= | Pictures

lcons ] Untitled2_Reports

My ConceptDraw

Audit_flowchart_multipage

Sample maps
ConceptDraw Docurnent

Web Export =M 321
& Onelirive Business process diagram BPMN
o 2.0
B Thiz PC v = i ConceptDraw Document y
File name: | Audit_flowchart_multipage w
Save as type: | CDDZ (ConceptDraw DIAGRAM Document,*.cddz) ~

# Hide Folders Cancel

Depending on the command you use to call the dialog, you get different save options. When you use the
Save and Save As commands, you can sawe in one of the following formats:

CDDZ (ConceptDraw Document )

CDD (ConceptDraw Document v7-9)

CDS (ConceptDraw Presentation )

CDT (ConceptDraw Template)

If you use the Save As Template..., command, you'll be able to save a template file respectively. To save
files in other formats, use the File / Export menu.

Save - saves the document.

Cancel - closes the dialog.
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Shape Properties

This dialog is used to modify properties of a shape. You can call this dialog from the Shape tab, from the
context menu or by using the keyboard: Ctrl + Shift + C

The dialog includes the following tabs:
Information - contains basic information about the selected shape.
Behavior & DoubleClick - determines how the shape interacts with other shapes, allows to
protect some parameters from changing. Also it allows to assign an action that is performed
when the shape is double-clicked.
Lock - allows to protect some properties of the shape from changing.

Information tab

Shape Properties x

Information  Behavior & Double Click Lock

ID: 303509 Sub ID: §7117
UEL IR Trianale right
Layer: W Layerl

Description:
Triangle right[1. Basic Shapes.cdl] I

Keywords:

triangle right

0 o1 e

When more than one shape is selected, it displays information for the primary selected shape.

ID - indicates the unique number of the shape in the current document.

Sub ID - indicates the number of the shape in its parent group. It's used for referring to shapes inside a
group.

Name - in this field you can type the name you want to assign to the shape.

Layer - assigns the shape to a layer.

Description - here is the short description of the object and the name of its parent library

Keywords - in this field you can enter the keywords which the search engines will use to include the
given shape in their search results.
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Behavior & Protection tab
Shape Properties x

Information  Behavior & Double Click | ack

Interaction Style: Behavior on Double Click:
- I‘. \'h— =
Shape No Action
Connector
*) Edit Text
Selection: e

Power Edit Table
v'| Shape Handles AL E

¥ | Control Handles
| alignment Box Go to Hyperink
Resize Behavior:
) Scale with Group
Reposition Only
Inherit Group Settings

Save Original Scale

) III Cancel

Interaction Style section determines whether the shape is a connector or not, and lets you turn any
shape into a connector if necessary:
Line(1-D) - the shape behaves as a line - it has a begin and end point (is a 1D-shape). Such
shape can be used as a connector.
Box(2-D) - the shape behaves as a 2D-shape, that is, it has width and height.
Selection Highlighting section describes how the shape is displayed when selected. The following
options are available:
Show shape handles - display or hide the handles on the shape's alignment box. This option is
on by default.
Show control handles - display or hide the control handles of the shape. This option is on by
default.
Show alignment box - display or hide the shape's alignment box. This option is on by default.
Resize Behavior section describes how the shape behaves within a group when the group is resized:
Scale with group - always resize the shape as the group is resized. This option is set by default.
Reposition only - simply mowve the shape without changing its size.
Use group's settings - the shape uses the behavior settings of the group to which it belongs.
Save original scale - if this option is on, the shape will keep its size when inserted into a
document with some other scale. Otherwise, the size of the shape will be changed according to
the scale settings of that document.
Group Behavior section describes how the group behaves:
Enable group's text - allows the group to hawe its own text.
Select group only - sets whether you can select shapes inside the group.
Reverse selection - changes the order of selecting a group and objects within a group (by
default, the first click selects the group and, the second - the object)
Only works if item "select group only" is toggled off
The Double Click section specifies the action, performed when the shape is double-clicked:
Perform no action - nothing happens.
Edit shape's text - turn on the text editing mode.
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Edit shape's table - display the shape parameter table.

Edit group in new window - open the Edit Group window, where you can edit the shapes inside
the group (this option is only available for groups).

Go to hyperlink - open the hyperlink (available if the shape has a hyperlink).

Action - perform a user-defined action. Two modes are available: you can choose an action from
the list, or choose.

Lock tab

Shape Properties X

Information Behavior & Double Click Lock

Lock:
Width Start point
Height End paint
Aspect Ratio Vertexes
X Position ¥ | Show text
Y Position Text Bound
Rotation Print
Horizontal Flip Delete
Vertical Flip
Fill Calc WH

Border

The Lock section allows to protect some properties of the shape from changing.
Fill - lock the fill options changing.
Line - lock line changing.
Width - locks/unlocks the shape's width against resizing.
Height - locks/unlocks the shape's height against resizing.
X position - locks/unlocks the horizontal (X) position of the shape.
Y position - locks/unlocks the vertical (Y) position of the shape.
Aspect ratio - if on, the ratio between the width and height is always preserved when the shape is
resized.
Begin point - for 1D shapes, locks/unlocks the begin point against repositioning.
End point - for 1D shapes, locks/unlocks the end point against repositioning.
Rotation - locks/unlocks the shape against rotation.
Vertex - locks/unlocks the shape against applying of the Edit Vertex tool.
Flip Xlocks/unlocks the shape against flipping horizontally.
Flip Y locks/unlocks the shape against flipping vertically.
Deletion - locks/unlocks the shape or its vertices against deleting.
Show text - sets whether to display the shape's text.
Don't print -sets whether the shape can be printed.
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Snap and Glue Settings
This dialog is used to configure the snapping and gluing settings. You can call this dialog from the

Document / Snap&Glue button = oor by using the keyboard: Ctrl+Shift+U. Also, here you can

specify whether snap and glue are active and to what items shapes will snap and glue. You can change
these settings at any time without affecting shapes that are already positioned or glued

Snap & Glue et

Snap to:

Objects

[ ]Ruler subdivisions

Grid

Guides

[ ]Geometry

[ ]shape Handles

|:| Vertices

[ ]angles
Connection Points
Glue to Guides

o Cancel

If Snap to is enabled, you can specify the conditions when snapping will be activated:
Objects - the shape will snap to the closest objects using dynamic guides as shown in the picture
below.




73

Ruler Subdivisions - the shape will snap to the imaginary lines coming out of the rulers' subdivisions.

Use this for very precise positioning.
25 3 35

Geometry - the shape will snap to the outlines of other shape. It is usually helpful when you need to

attach a shape to another shape.




Shape Handles - the shape will snap to resize handles of other shapes.

| v
i -
| r
L i *
-
1
1

Vertices - the shape will snap to vertices of other shapes.

Angles - Snap to dynamic guides during rotation of object to a multiple of 45 degrees.

[ EEmmRS

Connections Points - the shape will snap to connection points of other shapes.
Glue to Guides - allows shapes to glue to guide lines.

Snap sensitivity (the distance from which snapping is activated) can be set in the Options dialog, the
General tab.
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Spell Check

You can use the Spell Check dialog to find mistakes in the shapes text. You can call this dialog using
ABC
the spelling button on the Home tab.

When you call the dialog, the Spell Check engine checks all objects in your document at all pages. You
will see the results of the check in the next dialog.

Spelling >

Mat if dictionan:

v'ou can personalize BapidCiraw for creating flow charts using | |grare |
your cuztomized obje
[gnore Al
Add
Change to:
Suggestionz:
R apid Draw e
Fapid Draw d
R apid Drav
Cloze

The mistakes are marked red and underlined. You can select one of the words from the internal
dictionary and correct a mistake by pressing the Change button, ignore a mistake by pressing the
Ignore button , ignore all mistakes by pressing Ignore All button, or add a word to the User Dictionary
by pressing the Add button. To change an existing word you need to select it, correct it and press the

Change button. You can also delete words from the User Dictionary. To delete a word you need to
select it and press the Delete button.
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Text Properties

You can use the Text Properties dialog to set or modify various attributes of the shape's text. You can
call this dialog from the context menu of the selected object, or by using the keyboard: Ctrl + Shift + T.
When you call the dialog, three situations are possible:
1. One of the shapes is in the text editing mode - the all changes will be applied to the selected
text in the shape.
2. One or more shapes are selected - the changes will be applied to the whole text of the
selected shapes.
3. None of the shapes is selected - the changes are applied to default settings for new shapes.

The Text Properties dialog contains the following tabs:
Font - specifies the font, font style and other attributes,
Paragraph - specifies various paragraph properties. The end of a paragraph is denoted by the
linefeed character (inserted with the Return (Enter) key),
TextBlock - sets text block parameters of the shape,
Tabs - allows to add, delete or modify tab stops.

Font tab:
Text Properties >

Font  Paragraph TextBlock Tabs

Styles:
Font: Tahoma e [ Bold
Script:| 3ananHeLIA = [ntale
e | m . | [ Junderline
[ strikethrough
Color: | frce: [
[ superscript
Spacing: | 0 pt [ ] Subscript

L)) Cancel Apply

Font - allows you to choose a font from the list of installed fonts.

Language - sets the language (encoding) for characters. It's required to exchange documents with
applications which don't support Unicode, and with ConceptDraw 1.x.

Size - specifies the font size in points. 1 point = 1/72 inch.

Color - sets the text color. You can choose a color from the color palette, or set a custom color.

Spacing - specifies how much to increase or decrease the distance between characters (in points). Enter
0 for normal spacing, a positive number - to increase spacing, a negative number - to decrease spacing.
The Styles allows to apply one of the following styles to font: Bold, Italic, Underline, Strikethrough,
Superscript, Subscript.
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Paragraph tab

Text Properties x

Font Paragraph TextBlock Tabs

Indentation Spacing
Before:

First line: | 5 =fore: [ Opt
After: | 0 pt

From left: | 0in Size

_ () Percentage
From right: | 0in 0 o
(®) Abzolute

0in

Horizontal alignment
(JLeft (@ Centered ()Right

) Concel | [ o0l

The Horizontal Alignment section describes how the paragraph is aligned relative to the shape's text box.
The following alignment types are available:

Left - to the left side of the text box,
Centered - the lines are justified with respect to the center of the text box.
Right - to the right side of the text box.

The Indentation section allows to set indents for the paragraph in millimeters or inches (depending on the
measurement system of the document).

First Line - specifies the indent for the first line of the paragraph,
From Left - specifies the left indent for all lines of the paragraph,
From Right - specifies the right indent for all lines of the paragraph.

In the Spacing section you can set the distance between the lines of text. The distance is specified in
points (though you can use other units of measure too). A positive value increases the distance, a
negative value - decreases the distance.

Before - changes the spacing between the current and the previous paragraphs,

After - changes the spacing between the current and the next paragraphs,

Line - changes the distance between the lines for all selected paragraphs. When you set the
value in percent (120%,150%, etc) the spacing will be based on the font size. Also, you can set
a fixed value in points. The default value is 100%.
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TextBlock tab

Text Properties x

Font  Paragraph TextBlock Tabs

Vertical Alignment

(OTop
(® Middle
OBDtb:um
Margins
Left: | 0.06in Top: | 0,06 in
Right: | 0,06 in Bottom: | .06 in
Text Backaround

0 Concd | [ roni

The Vertical alignment section determines how the text block is positioned relative to the shape's text
box:

Top - mowes the text to the top of the text box,
Middle - centers the text in the middle of the text box,
Bottom - moves the text to the bottom of the text box.

The Margins section describes margins for the text block (the margins are specified in millimeters or
inches depending on the measurement system of the document).

Left - specifies the left margin for the text block,

Right - specifies the right margin for the text block,

Top - specifies the top margin for the text block,
Bottom - specifies the bottom margin for the text block,

Text Background allows to choose a background color for the text.
Transparent sets transparent background for the text (this option is on by default).




Tabs tab

Text Properties

Font  Paragraph TextBlodk Tabs

Tabs:

Add

o)

Modify

The Tabs table contains the list of current tab stop positions. The left column shows the tab position, the
right one specifies the alignment type with respect to the position.
Tab Stop Position area allows to modify the tab position, selected in the Tabs table.
Default Tab Stop - specifies the default tab position for the entire shape. By default, it's 1/2 inch.
The Alignment section specifies how text is aligned with respect to the tab position:
Left - places the left edge of the text in the specified position,
Center - places the center of the text in the specified position,
Right - places the right edge of the text in the specified position,
Decimal(.) - if there's the point separator (.) in the text, the text is aligned by the point.
Comma(,) - if there's the comma separator (,) in the text, the text is aligned by the comma.

Tab stop position: g 50in

Alignment: (&) Left

Remove

Cancel

{2 Center
IRight

O Point {,
{2 Comma

Default tab stop: | g.50in

)
()

Remaove All

Apply

The picture below demonstrates possible types of alignment:
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Left Center Right - Decimal Comma
Left Center Righ 123145 123{45
Left1 Center1 Right1 123114511 1231451
Left22 Cenfer22 Right2 12(4522 12,452

Tab stop positions are shown with red lines.

Add - adds to the Tabs list the tab stop described in Tab Stop Position. For convenience, after you click

the Add button, the setting in the Tab Stop Position area is increased by the value of Default Tab Stop.
Modify - replaces the settings of the tab stop selected in the Tabs list with the settings, displayed in the
Tab Stop Position field and in the Alignment section.
Remove - remowves the tab stop position selected in the list.
Remove All - removes all tab stops from the list.
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View Sections

ovaRREEATEES2EIES G SSER

Height+Child380.TextHeight+Child380 TextWidth*0.7 *Variables.Ys

Width 200 Flip¥ FALSE

Height coo Flipy FALSE

Angle 0 LocPink Width*0.5

GPinX 1422.64 LocPinY Height*0.5

GPinY 1211.21

Controls X Y HDyn YDwn ¥Behaviour ‘Eehaviour Comment

1 -1t Controls ¥2+(Child44 Controls X1 Controls ¥1 o = IFiCustomProp¥al| "Comment"
2 Width*0.5 Height+Child220 Tex| Controls X2 Controls ¥2 o =_IF{CustomProp ¥al| "Categories "
3 -0.40in*Docicale | Height*0.5 Controls %3 Controls ¥3 a = IFiCustomPropval| "values "

4 Width*0.5-TextWidt| -TextHeight*0.5-50 | Controls X4 Controls ¥d o =_IF{CustamProp ¥al| "Heading"

This dialog is used to display or hide existing sections of the Shape Parameter table. If the
corresponding option is enabled, the section is visible, otherwise - it is hidden. View Sections dialog:

e
=
&P
e
e
e

Object Transform - display/hide the Transform section.
Geometry - display/hide the Geometry section.

Line Format - display/hide the Line Properties section.

Fill Format - display/hide the Fill Format section.

Protection - display/hide the Protection section.

Miscellaneous - display/hide the Miscellaneous section.
Connection Points - display/hide the Connection Points section.
Control Handles - display/hide the Control Handles section.
Variables - display/hide the Variables section.

Text Transform - display/hide the Text Transform section.
Character Format - display/hide the Character Format section.
Paragraph Format - display/hide the Paragraph Format section.
Text Block Format - display/hide the Text Block Format section.
Text Tab Stops - display/hide the Text Tab Stops section.

Text Fields - display/hide the Text Fields section.

Actions - display/hide the Actions section.

Custom Properties - display/hide the Custom Properties section.
End Points - display/hide the End Points section (available for 1D shapes and
connectors only).

Glue Info - display/hide the Glue Info section (available for 1D shapes and connectors
only).

Data Sources - display/hide the Data Sources section.

Data - display/hide the Data section.

Rapid Draw Object - display/hide the Rapid Draw Object section.
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Floating Panels

Some tools and features in ConceptDraw DIAGRAM are accessible from the floating panels. You may
find here particullar_tools and resources that you might need while working with graphic documents.

—r—
=[]

Click the button " on the View tab to find a needed panel in the drop-down list.

Output

Library

Solutions

Pages

Layers

Arrange & Size
Format
Hypernote
Presentation

Info

Custom Properties
Advanced

Text

My ConceptDraw

EmrEMeOf4«TiwEEE I

Colors

Status Bar

@

Restore Panels State

Qutput

Library
Solutions
Pages

Layers
Arrange & Size
Format
Hypernote
Presentation
Info

Custom Properties
Advanced
Colors

Status Bar
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Solutions

ConceptDraw DIAGRAM provides an access to an online senice that delivers additional product
extensions. This is a time saving assistant for generating business documents and presentations.
ConceptDraw Solution Park is an online collection of visual solutions for ConceptDraw products. It
contains many subject areas for professional applications. Solutions panel provides the list of available
solutions in alphabetical order.Access the panel from the Home tab, or using the Panels list at the View
tab.

Solutions

P Basic Shapes i

[
k Iy ConceptDraw /

P 25 Typical Orgcharts

1. Search window. You can search for library objects. Enter a keyword or an object name in the

search field. The object will be found and displayed in the Library panel, also solutions displayed in the
Solutions panel will be filtered according to the keyword.

brary  # X

Solutions | Pages | Layers { » | Searchresults ..~

|Fln:-'fx'n::hart | ! o

» Basic Shapes Il - Brocess
¥ My ConceptDraw - step
b 25 Typical Orgcharts

P Accounting Flowcharts Prepare
conditicnal =

P Active Directory Diagrams -

n

2. Search in ConceptDraw STORE. You can run the STORE to search for the the proper solution in
Solution Park
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3. Solution section. This section contains the list of available solutions in alphabetical order.

The following options are available here:

a) Use the drop-down button to preview Libraries, Templates and Samples contained in the certain
solution. You can open them by click. A library context menu appears when you right-click a library
preview. It helps you to interact with libraries.

b) Click to purchase paid solutions using the ConceptDraw STORE application.

c) Click to download and install a free, or previously purchased solution using the ConceptDraw
STORE application.

d) Check, to view just solutions that are already installed.

* frea Charts
~ Libraries
e
>
e charts
= Templates
a -“ i
Mrea chart
| ‘ B ~ Samples
fal
¥ AndroidOser Interface
»firea Charts
¥ Artwork
» Astronomy b
& ATM UML Diagrams ¥ Software Develapment
ATM UML Diagrams _
Audio and Video = Andraid User Inteiface
Connectors
» audio, Video, Media stalles ATM UML Diagrams

& Audit Flowcharts

— c
Bre, . \—‘\

¥ Block Diagrams v
| Only Installed Solutions

+ Finance and Accountimg

Accolnting Flowcharts

% Updates

d 4 installed
Audit Hawcharts

¥ &ndroid User Interface
¥ Area Charts

¥ Artwork

¥ Astronomy

» Audio and Videa

Connectors
¥ Audio, Video, Media

¥ Austraha Map
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Pages

Access the panel from the Panels list at the View tab. Work with pages of a current document. There are
two page viewing modes. To switch between modes, use the tabs at the bottom of the Page panel. You

can operate pages using the page context menu.
Preview Mode

BEFOCHR
“ Home  Shape  Document  View  Share  Developer

n, ' E %& i E 0 [ Rulers ] Page Breaks aq EBEL N
B [J G [] Shape Sizes
Pages Layers cu"‘:.;{mw Libraries nar:.s.:xg: Format Advanced Info D] Guides L] Shape Controls Zoom|150% -
Side Panels View Zoom
-
. Pre-audit
= = o = Select for audit >
m e e Y
-
Flowchart 1
- How long does on Closing meeting | W)
= ’ | -site audit take? at audit site
LN} --
Flowchart 2
“F - SUpEEoy Written audit and
- - reviews field work > report mailed
=_= and report
Flowchart 3
v
Previews | Tree PageLst < [ Fowchat 1(1/5) -[>]4][
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Panels  Window

Sahutions
Pages

Layers
Asrange & Size
Format
Hypemate
Presentation
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Tree Mode

The Tree view of the page shows the diagram as a hierarchical list of objects. Moving the cursor through
the list, you navigate through the diagram's objects.

B MHE ConceptDraw DIAGRAM - [Flowchart-multipage - Flowchart 1] - [m} *
“ Home Shape Document View Share Developer D-©-a_-&x
s ¥ B 4@ oy ssxco B G
Grid [ ] Shape Sizes .
Pages Layers coneh ptDr - Libraries A&r%:\:ge Format Advanced  Info Guides [] Shape Controls Zoom|127% - Pui\els Wiridow
Side Panels View Zoom Panels & Windows

f
.
»
»l

[ ] e ' Pre-audit Audit field work
~ [ Flowchart 1 - Select for audit ! notification letter audit begins

I] Terminator [128695) L ¢ »
»  17{Tagged Document
[ Data Transmission [105998]
» 17 Object [245641]
I Stored data [224704] How long does on
L1 Subroutine [303529) -site audit take?
> 7 Object [321668]
I Data Transmission [321672]
» 17 Object [321673]
» 1 Tagged Document
» 17 Object [321681] Supervisor
ju| Terminator [321685) reviews field work LS ?d{ re(1:|1UPst
I Decision [128687] and report reconsideration
I Smart Connector [321736] .
]:[ Smart Connector (321737]

End of audit

[ Flowchart 2
»  [)Flowchart 3
»  [YFlowchart 4 Reconsideration L

¥ [7)Flowchart 5 .

Flowchart 1(1/5)

-[>[4] |
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The pages of your ConceptDraw DIAGRAM document displayed as icons with previews, so you can
easily navigate through your document.
The active page preview.

g

Flovwechart 2

Double-click name to rename page.To reorder pages use drag & drop.
If the page has background, it is marked with a background icon.

Preview of the page, that is assigned to be a background page.

Fage?
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My ConceptDraw

My ConceptDraw panel displays DIAGRAM's stuff stored in the My ConceptDraw folder on the user's
computer: The search bar makes it easy to navigate folder's content.

e Document files in CDD and CDDZ format;

e Library files in CDL format (indicated by the letter L),

e Template files in CDT format (indicated by the letter T);

¢ Slide presentations in CDS and CDSZ format (indicated by the letter S).

Subfolders are also displayed if they contain these formats of documents. Create a shortcut to any folder
using Windows Explorer, place it in the My ConceptDraw folder and it will also be displayed on the My
ConceptDraw panel as a subfolder. You can drag documents between folders. Access the panel from the
View tab, or using the Panels list at the View tab.

My ConceptDraw o x

|prc:cess

Documents list filtered by "process”. B

7
31

P

-I: & &

FTA_diagram
=]

Mested production process
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When you hover over a document icon, a tooltip appears that contains a preview and document

metadata.

My ConceptDraw I x
| |
PE— M
Q00
Numbers_1-10

Q00

Mumbers_1-11

Supply of goo

000
000

Title: Mumbers_1-10

File Size : 114.02 KB

Last Modification:
2023.08.03 13:35
Destination:
Chlsers\annat\DocumentsiMy
ConceptDraw\Mumbers_1-
10.cdl

LY
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The context menu allows you to create a new document, delete a document, adjust the preview size,

sort previews by name or date, and show the location of the document (folder with the document in

Windows Explorer).

My ConceptDraw I x

Open

Mew Document

Purchasing flowck )
Show Location

= Delete
€ Preview
Sort By
Supply of guows

e
¢ X0

Time_Management

} Busines_processes
* DIAGRAM

¥ Sample Diagrams - Shortcut.Ink
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Layers

You can call the dialog from the View tab by clicking the Layers button
Dialog shows layers and allows changing of properties

Layers X
Layer 1 F 4 O .
Layer 2 F 4 o .
Layer 3 F o & |:|
add || Delete Select Objects

Layer 1

()

g (8

=1

|

Layer 1 F o o .

Select Ohjects on Layer]

Layer's Name
Visible (Invisible)
Unlocked (Locked)
Printable

Layer's Color

Active Layer

Add Layer

Delete Layer

or using the Panels list.

Double-Click to rename

On/Off Layer visibility

Enable/Disable editing Layer
Enable/Disable printing objects of Layer

Change the Line Color of all objects on
Layer

On/Off color changes with check

You can change any properties of this
Layer

Add new Layer

Delete the current Layer

Select Objects on Layer Select all objects on current Layer
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Library

CICIC)
0]
You can call the dialog from the View tab by clicking the Libraries button ““~ or using the Panels list.
Wide collections of shapes and Clip arts help you create a different types of diagrams, as well as various
sorts of technical drawings.

Library 1 x
€ » | Basic Shapes v..--

Triangle right

-~

Triangle rounded

.1. Libraries section displays the opened libraries. You can cause a list of opened libraries by using
the drop-down button.

Press the navigation arrows <> to navigate through libraries.

Press the Close icon Q to remowe a library from the Library panel.

Library X

£ »  Histograms =

Basic Shapes
Flowchart
Histograms g
Data flow dia...
Frequency RIstograrnm = |

Frequency histogram

You can manage the libraries using the context menu and Library Properties Dialog
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2. Objects section displays objects containing in the active library.

There are a few different methods for placing an object into your drawing:

¢ Click on an object and then click on the document, at the place you want the object to be inserted.
e Perform a drag-and-drop from the library to your document.

¢ Double click on an object’s icon in the library to place an object in the center of your document.
You can manage library objects using the context menu and Library Item Properties dialog.

Some of ConceptDraw libraries contain objects, identified by a blue tile in the library preview on the
Solutions panel.

| )

¥ Circular Arrows Diagrams

* Libraries

*
- - ¥ - e

Circular arrows diagrams

¥ Samples

Such objects added to a document page can be edited by using the Action buttone menu. To open
the menu select an object and click the action button in the upper right corner of the object.
o

Add Element
Remove Element

Elements Mumber

ConceptDraw DIAGRAM User Interface Reference © 2024 CS Odessa corp.
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ConceptDraw DIAGRAM provides tools to help ensure the shapes in your diagram are aligned and
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spaced well. That helps make your drawing as clear as possible and give it a professional look. Access

the Arrange & Size panel from the Home tab, or using the Panels list at the View tab.

Arrange & Size

¥ Order

O B R

Back Front Backward Forward

* Align and Distribute

= g = o0 8 o
Left Center  Right Top Middle  Bottom
OF Horizonta - =

w Align to Page

¥ Size
Width 0.96in | = Lock Proportions

Height 0.83in

* Position

X 3.95in

¥ 2.98in

LI

¥ Rotate and Flip

Angle 0.00 deg | =

Fin Center-Center -
- S [ -
N A s Flip 1 A
90°CW 90°CCwW 180 ° Vertical Herizontal

¥ Group and Lock

=t 2

P T

Group UnGroup  Edit Lock  UnLock
Group

¥ Make Same

B = o

Size Width  Height

B | E B # §
Left Center  Right Top Middle Bottom

e Order

Here are object order tools. They help you control the placement of overlapping objects.

¢ Align and Distribute

Align objects without changing their spacing using the Left, Central, Right controls to set a horizontal

alignment and Top, Middle and Bottom controls to set a vertical alignment.

Distribute the space between object's control frames using the Vertical and Horizontal distribution.

¢ Align to Page

Align selected objects relative to the edges of the page.
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o Size
Set the size of the object in the units specified in the Options.

e Position
Set the position of the object in the coordinate system.

¢ Rotate and Flip
You can rotate objects rotated clockwise and counterclockwise in 90 and 180 degrees . You can flip
them vertically, flip them horizontally, or rotate using the Angle and Pin.

e Group and Lock
You can group Group and Ungroup selected objects. The Edit group button allows you to change
objects within group using a special window for edits..

e Make Same
You can make the certain properties of selected objects identical.
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Format

In ConceptDraw DIAGRAM you can customize the appearance of objects by changing their fill colors,
line weight and style, text colors and fonts. Access the Format panel from the Home tab, or using the
Panels list at the View tab. Format panel has different appearance depending on the object selected.

Format Panel for a Library Object

Format qx
w Style ~
Theme Basic Theme - |

-
- 0 O

>

w Fill

Type Solid -

w Border

Type Line -
- g [1002=
Pattemn i—
Weight 1pt z
Comer rounding Din -

w Shadow

Type Drop Shadow ~
- I a0 2
Angle 135 deg

(Offset 0111in
[ Draw below all shapes

w Make Same Attributes

b S N ¢
Fill Border  Text All
Format W

o Style

You can apply pre-designed formatting to your drawing with one click. The embedded style themes can
be applied to an entire object (fill, line and text) or to object's elements, such as line, and text. You can
create your own style containing custom colors, effects and text formatting by choosing one of the
embedded styles and modifying it.
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You can save a new style in your current ConceptDraw DIAGRAM document, or save it on your local

i

computer to be used with other ConceptDraw DIAGRAM documents. Use the
custom themes.

icon to sawe , or load

Theme X

Theme
Mame: | Basic Theme

Description: | Thic ic Basic theme Load Theme
Save Theme
=
o Fill

Change the fill color of selected object.

) Border
Change line color and line pattern.

o Shadow
Select shadow style and color.

. Make Same Attributes
Make certain properties of selected objects identical.
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Format Panel for a Connector

Format 1 x
¥ Style
Theme Basic Theme - i
- - o
< >

v ¥ T

¥ Connector Type

2 0 %W %

Direct Arc Bezier  Smart  Curve

¥ Stroke
Type Line v
-v g 10032
Pattemn L=
Weight 1pt z
Comer rounding 0 mm -
¥ End Points
Start _——
End - -
Size [ ]

¥ Margins and Path

Margins 0.24in z
Viewless Path 0% = 0% =
Begin End

¥ Make Same Attributes

T

Stroke  Text
Format

e Style

Built-in style themes can be applied to connectors as well as to entire objects (fill, line, and text). You
can apply pre-designed formatting to your drawing with one click. The embedded style themes can be
applied to an entire object (fill, line and text) or to object's elements, such as line, and text. You can
create your own style containing custom colors, effects and text formatting by choosing one of the
embedded styles and modifying it.
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You can save a new style in your current ConceptDraw DIAGRAM document, or save it on your local

computer to be used with other ConceptDraw DIAGRAM documents. Use the

custom themes.

Theme

Theme
Marne:

Description:

Basic Theme

This is Basic theme

Apply

x

Load Theme

Save Theme

Cancel

e Connector Type

Change the type of connector.

e Stroke

Change the type of the stroke of the selected connector.

e End Points

Change the form and size of the arrowheads of the selected connectors.

e Margins and Path

You can create connectors that do not have a visible connection to
the objects by adding two-sided margins, or one-sided indents - path.

e Make Same Attributes
Make certain properties of selected objects identical.

1

icon to sawe , or load
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Format Panel for a Raster Image

Format o x
Image placement | Original size

Offset Din = Oin =

X Y

Choose image from file...

¥ Raster Adjustment
Brightness:
Contrast:

Shadows:

Gamma:

- Em O W .
o

AF Ak A A 4k
X

Saturation:

Crop

¢ Brightness settings allow you to adjust the brightness of all colors and the difference between the light
and dark parts of an object.

¢ Contrast enhancement allows you to adjust the color of a bitmap while presening shadow and highlight
detail.

¢ Gamma effect enables picking up details in a low contrast image without significantly affecting the
shadows or highlights.

¢ Saturation effect allows you to adjust the colors and their intensity by changing the percentage of
white in the image.
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Access the panel from the Panels list at the View tab. Edit object behavior, protection, and double-

click properties.

tiy At

=) B Teat
Posver Edt Table
Bt Group Windkrw
Go 1o Hyperink

Misellaneos

T Brhavicur oo Double Clhick

= X Shape | Shape Handes
Cornecioe »F | Conbrad Handes
* | Aligremers Bax
# | Hide i Preseriaton
= Soale with Group o | Groop Text
R son Only St Growpe iy
[rwgnit Grongn Selbngs ) Sl i o Pt
Save Crignal Soale Seledt Chld Fegt

Advanced [
* Lock

\ickh Sk peird
Height Frel pet
Fapect Rt Verleoss
X Poston 5| Sharw bt
¥ Pty Teead Banrnd
Ralaen Prird
Henrontal Fip Dedete
‘erbical Flp Group
i Calz YWH
Eicwvder

e Lock
Define parameters of an object that should be locked from changes

e Behavior on Double Click
Define Double-Click actions:

Perform no action - No actions on Double-Click;

Edit text - Edit a text of an Object;

Powver Edit Table - Edit Shape Parameter Table;

Edit group - Open a new window for grouped objects editing;

Go to Hyperlink - Open hyperlink;

Action - Choose one actions, assigned to object. The assigned action will be performed continuously
with Double-Click.

e Miscellaneous
2D Shape - The selected object is assigned as two-dimensional. You can resize it by changing its

height and width;

Connector - The selected object is assigned as one-dimensional. You can resize it by changin its height
only. It can be connected to another with connecting points (the same as connector);

Scale with Group - All objects scale similarly and simultaneously around group center;

Reposition only - Group resizing will move grouped objects without resizing;

Inherit Group Settings - Apply the entire group settings while resizing individual objects from this group;
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Save Original Scale - if this option is on, the shape will keep its size when inserted into a document
with some other scale. Otherwise, the size of the shape will be changed according to the scale settings
of that document.

Shape Handles - Show/Hide handles of selected objects

Control Handles - Show/Hide control handles of selected objects

Alignment box - Show/Hide alignment frame around selected objects

Hide in Presentation - Allows not to display selected objects in Presentation mode

Group text - Enable/Disable object text editing in group;

Select group only - Enable/Disable selecting individual objects within a group.

Select Group first - The first click on the object that is included in a group will select the entire group,
the next click will select this object within the group.

Select Child First - The first click on the object that is included in a group will select this object within
the group, the next click will select the entire group.
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Info

You can call the dialog from the View tab by clicking the Info button o or using the Panels list.
Shows the information about selected object. (If several objects are selected , the dialog shows the
information about object, selected first).

Info o x
* Meta Data
Mame Choreography Task
Description Choreography Task[Business

Process Diagram-
Choreographies. cdl]

Keywords task

* Developer Info

iy 319762

Sub ID 57270

Layer B Layer 1
e Meta Data

Contains meta data related to an object: name, description including name of the parent library and
keywords that will help to search this object.

e Developer Info

Contains: ID - the unique identification number of the object within current document;
Sub ID - the unique identification number of the object within current group;

Layer - number of Layer where object is located.
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Hypernote

Use this panel to assign text notes and hyperlinks. You can add hyperlinks to any ConceptDraw object.
The hyperlinks can link to another page or object in the current document, or a Web site. Access the
panel from the Panels list at the View tab, from context menu of the object, or using the Hypernote
functional button.

t}g Cut

Copy
Paste
Delete
i Change Shape [
£ Shape Properties...
Text Format...
Fit To Text
. Object b
o Hypernote
Lock J
Add Custom Properties
Hypernote 1 x

Title

| o Title
Click to enter the Title of Hypernote

|BPI'v1N 2.0 Documentation

Hypemote
Documents Associated with Business Process Model And MNotation™
{BFVIN™) Version 2.0 ¢ Hypernote
Click to enter text Notes.
e Hyperlinks
Click to add a hyperlink using the Set
Hyperlink dialog.
You can edit hyperlinks using context
menu.
Hyperiinks
65 BPMMN Nomative Documents
@ EPIMN v2.0 Examples
[ Create Application
Goto Link
Edit Link

Delete Link EI
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Set Hyperlink

Set Hyperlink (==

Link Title:

(@ Link to WEB. Enter Internet address:

i concepteraut.com

(©) Link to FILE. Enter file address:

Set relatie fie path

(@) Link to this document. Select Page or Object:

£ Pagel P
[0bjID48505]

- [ObjID50274]
[ObiID50275]

+~ [ObjID50276]
Research & Development [0bjID3288]
Production & QA [0bjID50191]
Marketing [0bjID50200]
[ObjID1196]

- Deployment Flowchart - New Produ [ObjID50277] L
[0bjIDS0278]

- [ObjID5027]
[0bjID50280]

- [ObjID50281]
[ObjIDS0282]

- [ObjID50283]
[ObiID50285)

+~ [ObjID50286]
[ObiID50287]
[0bjID50289)
[ObiID50288] ]

Hyperlinks can be of the following types: a hyperlink to an Internet address, files, or to a page/object
in the current document..

Link to Web - you can add one or more hyperlinks to an Internet address. When such link is opened,
the program launches the default browser and goes to that address. You can type the hyperlink
address manually, or and copy and paste the link from the Internet browser.

Link to FILE - you can add a hyperlink to other files on your computer or the ones accessed from your
local network.

Link to this document - Allows adding hyperlink to another page or shape in the current document,
Go to Link - allows to go to the hyperlink without closing the dialog.

You can assign hyperlinks to the shape's text as well. This can only be done in the text editing mode.
To open this dialog from the context menu make a right mouse click on the selected text.

]

u}‘a Cut
Copy
Paste

Select All

Inductiorfily

Eold

Italic

Underline
EL]
Text Format... weeds

HyperLink »

bo Edit..  Ctrl+Shift+E

The link will be assigned to the selected words/characters.
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Presentation

Use Presentation panel to operate ConceptDraw DIAGRAM dynamic presentations. Access the panel

from the Panels list at the View tab.

Presentation q X
w Slideshow
4 > M B
Previous  Play Mext Exit
w Options

[ | Loop slideshow

[ ] Autoplay Interval 20 sec
Show Slide Breaks

Show Slide Previews

Auto Hide Slideshow Controls

Slide Size |Set Slide Size as Screen - |

Output Device |Generic PrP Monitor primary {1¢ '|

ConceptDraw DIAGRAM User Interface Reference
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Slide Show

Operate slideshow using these command buttons.

You can play a slide presentation of the current document Slides will be created from document's pages.

Hower the mouse over the bottom of the screen to access the presentation control panel.

Create -
Application L

Applicatios

Hire
o i b=

Collect

Endes Teedbimk

CIEXa

ConceptDraw DIAGRAM User Interface Reference © 2024 CS Odessa corp.
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Options

Set the consecutive order of Slide Show.

Change document size to fit monitor resolution.

When the Presentation panel is active, the slide frame is highlighted in green. Thus, you can see how
the size of a real page fits the dimensions of the monitor that you select for the presentation. You can
change the size of the presentation slide so that it matches the dimensions of the presentation monitor.
ConceptDraw DIAGRAM supports multi-monitor usage. The only limit is that ConceptDraw DIAGRAM
can run only one presentation at a time. So, you can run a presentation in one monitor and have the
same or a different document open for editing on the second monitor. By default every presentation is
displayed on the primary monitor.To run a presentation on the secondary monitor select the monitor from
Output Device drop-down list.

ConceptDraw DIAGRAM User Interface Reference © 2024 CS Odessa corp.
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Text

ConceptDraw DIAGRAM provides tools to set or modify various attributes of the shape's text.. You can
change the format of text in a selected shape using text formatting options. Access the panel from the
Panels list at the View tab.

Toxt 1x
* Fos
[ Tatma -] [
- B ft
- = =

% Indanie
P in &4
From ik wn M
Traaght In 1=
* Spucing
= o =
tres (T
BdaaPoagmh G |2
Hulyagch O (5]
- um_-lhq
Top in =
Rgre 05 =
lomom LT
Left L
* Tabscitig

B

Tebsizea Rrrent
(=Lat
iGenier
) Deorra

Font

Font - allows you to choose a font from the list of installed fonts and define the font size in points. 1 point
= 1/72 inch.

Upper color selector - sets the text color. You can choose a color from the color palette, or set a custom
color.

Upper opacity slider - sets the text transparency.

Lower color selector - sets the text background color. You can choose a color from the color palette, or
set a custom color.

Lower opacity slider - sets the text background transparency. You can apply any style to font: Bold,
[talic, Underline, etc.

e, ©
TEXT

| I T
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Alignment :

The Horizontal Alignment section describes how the paragraph is aligned relative to the shape's text box.
The following alignment types are available:

Left - to the left side of the text box,

Centered - the lines are justified with respect to the center of the text box.

Right - to the right side of the text box.

Top - mowes the text to the top of the text box,

Middle - centers the text in the middle of the text box,

Bottom - mowes the text to the bottom of box.

Text auto expand mode - If the object should contain a lot of text, this mode allows you to automatically
increase the width and height to accommodate the text in full.

" “adulgper ~ @
month,
Text auto expand mode "OFF" Text auto expand mode "ON"
Indents

First Line - defines the left indent of the first line in paragraph.
From Left - defines the left indent of all paragraph lines.
From Right - defines the right indent of all paragraph lines.

Spacing

In the Spacing section you can set the distance between the lines of text. The distance is specified in
points (though you can use other units of measure too). A positive value increases the distance, a
negative value - decreases the distance.

Character - specifies by how much to increase or decrease the distance between characters (in points).
Enter 0 for normal spacing, a positive number - to increase spacing, a negative number - to decrease
spacing.

Line - changes the distance between the lines for all selected paragraphs. When you set the value in
percent (120%,150%, etc) the spacing will be based on the font size. Also, you can set a fixed value in
points. The default value is 100%.

Before paragraph - changes the spacing between the current and the previous paragraphs.

After paragraph - changes the spacing between the current and the next paragraphs.
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Margins
Top - defines the top margin.

Right - defines the right margin.
Bottom - defines the bottom margin.
Left - defines the left margin.
2.3

ol

Sample text
for paragraph
ndents
dernonstration

Bample text for margins
demonstration

T =
In the picture above: 1 - Left margin, 2 - indent From Left, 3 - First Line indent.

Tab settings

Tab settings section allows to modify the tab position, selected in the Tab stops table.
Tab stops - specifies the default tab position for the entire shape. By default, it's 1/2 inch.
The Alignment section specifies how text is aligned with respect to the tab position:

Left - places the left edge of the text in the specified position,

Center - places the center of the text in the specified position,

Right - places the right edge of the text in the specified position,

Decimall.) - if there's the point separator (.) in the text, the text is aligned by the point.
Comma(,) - if there's the comma separator (,) in the text, the text is aligned by the comma.

Tab stop positions are shown with red lines.

Add - adds to the Tabs list the tab stop described in Tab Stop Position. For convenience, after you
click the Add button, the setting in the Tab Stop Position area is increased by the value of Default Tab

Stop. Remove EI removes the tab stop position selected in the list.
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Custom Properties

This dialog is used to view and edit user-defined data of shapes. You can call the dialog from the Shape

menu by clicking the Custom Properties button lll or using the Panels list at the View tab, or from
the context menu in the document window. Prior to calling the dialog, select the shape which properties
you're going to view or edit. If there are several selected shapes, the properties will be shown for the
shape with primary selection (the one that displays green handles).

If the shape has no custom properties, you'll be offered to Define Custom Properties.

)

Custom Properties B x
& Is] 2 * (ustom Properties

Define Custom Propertes

Custom Properties %

* Custom Properties

My BOL Dol o

Prorrpt

[ Cstorm Proper bes

The upper part of the dialog displays the list of custom properties of the shape. The list contains the
names of the properties (the Label field in the Define Custom Properties dialog) and the values of the
properties (the Value field in the Define Custom Properties dialog). Depending on the value format, the
value field may be either an input field, or a drop down list. Prompt - displays the tip for the property (if it
was defined in the Prompt field of the Define Custom Properties dialog). Add Custom Properties... - calls
the Define Custom Properties dialog where you can edit the existing properties, or add new ones.




Floating Panels

Colors

112

Colors

Colors panel is a horizontal bar at the bottom of a document window. Access the panel from the Panels
list at the View tab. Colors panel provides quick access to manage the color of fill ,line and text of the
selected object. Switching between controls is done by clicking on the left edge of the panel.

Fill

O
a : . J '..
Reci‘:%ngle
rounded
CA ® »

< | Jrder process - BFMN ... (1/4 - | >[4

Colors

EE@HHHHHHHH HE

Text

o
a : L J '..
Hectlgngle
rounded
e »
< | Irder process - BPMN ... {1/4. - [ > |4
Colors
A [IRCTE T ——_
— -

A
A

L

Line
o
S
Rect?rngle
rounded
L @
< [Irder process - BPMN ... {1/4 - [ = [4]
Colors
;g!uuuuuuuu [
1
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Context Menu

ConceptDraw DIAGRAM enables access the most frequently used operations with objects via the
context menu. There are different types of context menu related to different pieces selected. The figure
below displays all the types of context menus. Howewer, actually, you can see only one menu -
depending on the selected item.

1 - Pages Context Menu
2-3 Library and Library Object Context menu

4 - Object Context Menu
5 - Text Context Menu

MNew Library
Close Library
Close All Libraries

Save Library as.. :

Send Library via E-mail..

BoinrHE Show Library File Location Draw DIAGRAM - [Audit_flowchart_multipage - Flowchart 1] - 0o x
Library Properties... O-@-a_8x

Bl o e bocmen w
Add Section
& cut Erw— P ocw [ Select Shape ~ ] A 53 Y\, & -1%1- HE'E é.%ﬁ ﬁ%‘ —GDD' %‘E} % H ABC, cht

B Copy

B BRf@AA

Al Co e .
Pa‘ste & Format Painter B I U A°A} Py s W Select Text OE ™K Canr::c{or Ralzwmd‘ Chain  Tree Ch‘:n: Snap ASerS:'zg: Format F\:Idﬂf: Spelling Ew::tg'e
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Page Context Menu

Context menu of the Pages panel provides fast and easy way to manage document pages. You can add
pages, remove them. or perform other page operations.

Pages I x
Pages | Solutions
.A
T -
e I~ e — =Y
£ T
- I'§ AddPage.
& == Insert Page
Marketin Duplicate Page
Renamne Page
Choose Background J
T
Set as Background for b
= ,E; Remove Page
'. View as ]
Adjust to Drawing Contents
Properties...
Internat

Create new document

Add Page - add a blank page at the end of the document
Insert Page - add a blank page below the selected page

Duplicate page - duplicate the selected page




Rename Page - rename the selected page
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Choose Background - assign a background for the selected page from a list of all document's

pages. By default, the new page has no background
Mone
Assistant 1

Chief Financial Officer
¥ Background

Set as Background for - set the selected page as a background to other pages. By default, the

new page is not a background page

All Pages

v [Mone

Azsistant 1
Chief Financial Officer

Background

Remove Page - remowe page from the document

View as - change the page preview appearance

¥  Large Preview
Small Preview

List

Adjust to Drawing Content - resize page to fit a content
Properties - open the Page Properties dialog

Create new document - Copy the selected page to a new document




Library Context Menu
ConceptDraw DIAGRAM enables manage libraries and objects using the context menus.
A library context menu appears when you right-click a library preview in the Solutions panel.

Solutions 1 x

Solutions | Pages | Layers

]

¥ Basic Shapes

* Libraries

Mew

Open...

Save as...

Send via E-mail...

Show File Location

Nl
N BpRyaa

Properties...
—_———a 7

r

T

New - create a new empty library.

Open - Open an existing library using the Open dialog.

Save - Sawe changes in the existing library using the Save As dialog.
Save as - Sawe a new library using the Save As dialog.

Send via E-mail - Send a copy of the file in an e-mail as an attachment.
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Note: The default location of the saved libraries : C:\Users\UserName\Documents\My ConceptDraw.
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Show file location - Show where the library is stored on the disk
Properties - Open the Library Properties dialog

The context menu of the library object that is called when you right-click an object in the Library pane
contains the most of commands from the library menu (see abowe), plus the library object management
commands.

Library ox
< ¥ | Flowchars -
Shapes A A

Mew Library
Close Library
Close All Libraries

Save Library as...
Send Library via E-mail...

Show Library File Location

A BAIHAA

Library Properties...
| Add Section

Cut

Copy

Delete

Changeicon

Mowve to Section b
Properties...

View as lcons
Yiew as lcons and Text

¥  View as lcons and Text Right

New Library - Create a new empty library.

Close Library - Close the currently opened library.

Close All Libraries - Close all libraries.

Save Library- Save changes in the existing library using the Save As dialog.

Save Library as - Save a new library using the Save As dialog.

Send Library via E-mail - Send a copy of the file in an e-mail as an attachment.

Note: The default location of the saved libraries : C:\Users\UserName\Documents\My ConceptDraw.
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Show Library file location - Show where the library is stored on the disk

Library Properties - Open the Library Properties dialog

Add Section - You can create library subdivisions - sections. Using sections is the best way to organize
a library with a large number of objects. The drop-down arrow allows you to show/hide the content of a

section.

€ ¥ | Acvities -
-
Call Activity -
Collapsed
Activity Mark _
Task Types Add Section
C . Rename Section
annecting ..

Delete Section

Cut, Copy, Paste, Delete - you can perform the common operations with library items
Replace - Replace the selected library object with the object selected on a drawing page.
Change icon - You can replace the object icon with any graphic image using the Open dialog.
Move to Section - You can mowve objects between library's sections.

Properties - open the Library ltem Properties dialog.
You can change the Library items appearance:

Ubrary Library 3
4 ¥ Basicthapes = € »| Basicthapes = 4 3 Basicihages
L] v e
Teisagle
gtotlen.
Trsngle rsddeles B
|
| Rectamgle
Triangle redeeles Rectargle
rounded reunded
Saadium
- . Bedrangle v -
View as Icons View as Icons View as Icons

and Text and Text Right




Context Menu

Object Context Menu

119

Object Context Menu

ConceptDraw DIAGRAM allows you to access the most frequently used operations with objects via the

context menu.

Solutions

¥ Google Cloud Platform

¥ Libraries

e

o

6
O

o
e

Big Data

©

©

@

o
o

Compute

(8
Ingest
a__9 »

loud
1 Ih Ifcl Il‘i
Cut

Copy

Paste

Delete

Change Shape b
Shape Properties...

Edit Text

Fit To Text

Object 2

—>

Pipelines

Cloud
Dataflow

Hypernote
Lock 2

Custom Properties

Cut, Copy, Paste, Delete - you can perform the common operations with an object.
Change Shape - You can change the selected object to another.
Shape Properties - Open the Shape Properties Dialog.

Text Format - Open the Text Properties dialog

ConceptDraw DIAGRAM User Interface Reference
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Fit to Text - Make the sizes of object appropriate to the text size.

¢
ConceptD.
~_raw__-

o ® T
s S
“ConceptDraw =
& -- Tm—— —~ ——— __ ®

Object - Provide quick access to some options commonly managed from the Arrange panel. Also

enables select the object's text for further editing.

O Send ToBack  Ctrl+Alt+B
B} Bring ToFront  Ctrl+Alt+F
A Rotate Left (907 Ctrl+L
“b. FRotate Right (90°7) Ctrl+R
A Flip Horizontal  Ctrl+Alt+H

Eet  Flip Vertical Ctrl+ Alt+)
EEl Edit Text F2
IEI Group Ctrl+G
T

Hypernote - Activate the Hypernote panel.

Lock - Provides quick access to Lock options commonly managed from the "Lock" section of the

Advanced panel.
Custom Properties - Activate the Custom Properties panel.

120




121

Text Context Menu

ConceptDraw DIAGRAM allows you to access the most frequently used operations with text via the
context menu. There different ways to select a text. You can select a desired piece of text using the
Text Selection Tool, or you can select the entire text using the Edit Text command from the Object
context menu.

Copy
Paste

n.ﬁ Select All

B Eold

I ltalic

0  Underline

Text Format... s
HyperLink b

Cut, Copy, Paste, Select - you can perform the common operations with a selected text the same as
with object.

Bold, italic, Underline - Provide quick access to some options commonly managed in the Home tab.
Text Format - Open the Text Properties dialog.

Hyperlink - Open the Set Hyperlink dialog.
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Status Bar

The Status Bar is available at the bottom of the document window and displays information about the
current window's state.

g Vo O 4 | W memjmupﬂﬂWM.ﬂ‘wxwmmﬁﬁm
—|| B
Transa ]
m CD:I]U];II ction... Checkout Reply
enversetions
S R
SIDIE iz :
— = — Fagel (1/1) AL —
S
B . = c Colors -
= - vent
E -] SR sub-

Mouse: [ 272.79,179.12 ] mm

1. The Scroll Hand tool is used to scroll the document.

2. The Zoom Box tool is used to zoom in and zoom out, keeping screen focused on the selected
objects.

3. Fit to Page tool is used to zoom a drawing to fit the current document window.

4. Zoom Control tool is used to set the zoom level visually by scrolling the pointer left, or right.

5. Zoom Percentage tool is used to set a zoom lewel in percents.




Keyboard Shortcuts and Mouse Actions

DOCUMENT AND WINDOWS

Keyboard / Mouse
Ctrl + N

Ctrl + Alt + N

Ctrl+Shift+open Library

Ctl+ O

Ctrl+ S

Ctrl + Shift + S
F5

Ctrl + P

Ctrl + Alt + P
Ctrl + Alt + R
Ctrl + F

Ctrl + Shift + G
Ctrl + Shift + U
Ctrl + W

Ctrl + Tab

F3

Alt + F4, Ctrl + Q

Ctrl + F1

Operation

Create a new document

Create a new document from a template
Open an earlier saved template preview
Open a document/template/workspace file.
Save the active document

Sawve the document under a new filename
Start Presentation

Print the active document

Print Preview

Show Page breaks

Find and Replace

Set Grid properties for the active document
Set Snap&Glue options f

Close the active window

Activate the next window

Open Shape Parameter Table

Quit ConceptDraw DIAGRAM

Open About dialog
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VIEW

Keyboard / Mouse

Ctrl + “+”

Ctrl + “

Ctrl + Shift + Z

Click/ Click + Alt in Zoom Box

Ctrl + Shift + 0

Click in Print Preview

PgUp

PgDn

Ctrl + Home

Ctrl + End

Ctrl + PgUp

Ctrl + PgDn

SELECTING SHAPES

Select with Shift

Ctrl + A

Ctrl +T

Tab/ Shift + Tab

Shift

Operation

Zoom In

Zoom Out

Activate the Zoom Box mode

Zoom In/ Zoom Out

Set zoom to Whole Page

Change zoom lewel (in cycle)

Scroll one window space up

Scroll one window space down

Go to the top-left corner of the page

Go to the bottom-left corner of the page

Go to the previous page

Go to the next page

Allows to select several shapes

Select all the shapes on page

Activate Text Selection Tool

Select the next/ previous shape

Select objects without quitting the mode
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HYPERLINKS

Keyboard / Mouse

Ctrl + Shift + E

Ctrl + Shift + H

EDITING

Ctrl + Z

Ctrl+Y

Ctrl + X, Shift + Del

Ctrl + C, Ctrl + Ins

Ctrl + V, Shift + Ins

Ctrl + Alt +V

Ctrl + Shift + V

Del

Ctrl + D, Ctrl for dragging

Insert Vertex with Ctrl

Ctrl in drawing

LIBRARIES

Ctrl + Shift + N

Ctrl + Shift + O

Ctrl + Shift + |

Operation

Create / Edit hyperlink

Open hyperlink

Undo the last operation

Redo what was reversed by Undo

Cut the selection to the Clipboard

Copy the selection to the Clipboard

Paste

Paste Special

Paste in Place

Delete the selected shape(s)

Duplicate the selected shape(s)

Cut the line in this place

Add the new segment to the selected figure

Create a new library

Open a library

Replace the library object with page object
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SHAPES

Keyboard / Mouse

Ctrl + Alt + B

Ctrl + Alt + F

Ctrl + Shift + B

Ctrl + Shift + F

Ctrl + J

Ctrl+ H

Ctrl + L

Ctrl + R

Ctrl + Left/Right

Ctrl + Shift + Left/Right Arrow

Rotate with Citrl

Resize with Shift

Arrows

Shift + Arrows

Ctrl + G

Ctrl + E

Ctrl + U

Operation

Send to Back

Bring to Front

Send Backwards

Bring Forward

Flip Vertical

Flip Horizontal

Rotate Left (90 degrees)

Rotate Right (90 degrees)

Rotate by 1 degree

Rotate by 0.1 degree

Rotate around common rotation center

Toggle between resizing types

Movwe the selection one pixel at a keystroke

Move the selection a few pixels at a keystroke

Group the selected shapes into one

Edit Group

Ungroup




DRAWING MODES

Keyboard / Mouse

Ctrl + 1

Ctrl + 2

Ctrl + 3

Ctrl+5

Ctrl + Alt + 5

Ctrl + Shift + 5

Ctrl + 6

Ctrl+7

Ctrl + 8

Ctrl + 9

Ctrl + Alt + 9

Ctrl + Shift + 9

Ctrl +Shift + R

Ctrl+ 0

F2

Hold down Space

Shift in drawing

Alt for drawing or moving objects

Operation

Activate Select tool

Activate Text tool

Activate Line tool

Activate Direct Connector tool

Activate Arc Connector tool

Activate Bezier Connector tool

Activate Spline tool

Activate Rectangle tool

Activate Ellipse tool

Activate Smart Connector tool

Activate Curve Connector tool

Activate Rounded Connector tool

Activate Rapid Draw mode

Activate Eyedropper tool

Activate the Text Editing mode

Activate Scroll Hand tool

Constrained drawing (circle, square, etc.)

Invert (activate or disable) the Snap mode
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TEXT FORMATTING

Keyboard / Mouse

Ctrl + Shit + T

Ctrl + B

Ctrl + |

Ctrl + U

Ctrl + L

Ctrl + E

Ctrl + R

Ctrl + «”

Ctrl + "

Ctrl +Shift + “=”

Ctrl + “=”

Esc

APPLICATION

F1

Ctrl + "

Operation

Format Text

Bold for selected text

Italic for selected text

Underline selected text

Align on the left for selected text

Align in the center for selected text

Align on the right for selected text

Increase font

Decrease font

On/Off the text shifted above (superscript)

On/Off the text shifted below (subscript)

Finish editing

Call Help System

Preferences (Application Settings)
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